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11  Introduction 
 
Thank you very much for purchasing our product.  
DSS Player Pro R5 is a Dictation/Transcription system that supports assignments of various 
sizes, from individual users to multiple users.  
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1.1 DSS Player Pro 
 

DSS Player Pro R5 is a Dictation/Transcription system that supports assignments of various 
sizes, from individual users to multiple users. It can be used to capture highly compressed 
audio data with an Olympus VoiceTrek series IC recorder (hereinafter referred to as "the 
recorder"), and allows for real-time playback, editing, and insertion of index information. 
 
DSS Player Pro R5 and recorder support the playback of DSS, an international standard for 
audio recording, Microsoft-promoted WMA, and MP3. 
With peripheral devices connected, such as a DirectRec or foot switch, it provides a variety 
of additional functions, including audio streaming recording and remote control playback. 
 
The workgroup system supports Citrix Presentation Servers, and enables this product to be 
operated via Citirix Presentation Server Clients. 
 
It also supports the Terminal Service, allowing this product to be used via the Terminal 
Service with the DSS Terminal Service Client Driver. 
 
In addition to the Release 4 features, Release 5 offers the following functions: 
 

• Support for playback, editing, and encryption of DSS Pro files 

• Improved dictation comments, such as instructional comments and verbal comments 

• Support for the Microsoft® DirectShow® Filter 

• Support for Citrix Presentation Server/Terminal Service 

• Easy-to-see and intuitive graphical user interfaces 

• Option dialog boxes that allow for centralized management of settings 

• Button customization to link device buttons with commands, and to edit their details 

• Administrative functions (with System Configuration Tool) and settings of users, devices, and updates  
 

1.1.1 System Configurations of DSS Player Pro 

 
DSS Player Pro offers two system variants with different administrative configurations. 

• Stand-alone System 
With this configuration, an individual user enters the supplied license ID (for the single license), 
installs the system, and configures applications. User profiles (various settings for each user) are 
located on local PCs and managed by individual users. 
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About silent installation with a multi-license ID: 

See "Install Guide" for this installation.  
 

• Workgroup System 
With this system configuration, an administrator installs and configures the modules for each 
user, and centrally manages and operates them under a multi-license. 
This system requires License Manager to be installed to manage the multi-license.  
User profiles are placed in a shared folder on the file server. The administrator uses System 
Configuration Program to assist each user in configurations and installations. A significant part of 
user profile settings can be configured and locked with System Configuration Program. 
 

 
 

About Workgroup System configuration: 

For information on how to set up the DSS Player Pro R5Workgroup 
System, refer to Install Guide. 
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1.1.2 Modules and Tools 

 

• Dictation Module 
This is an application for authors.  It is used mainly to download an audio file recorded with a 
DVR (Digital Voice Recorder), or to record an audio file directly onto a PC.  It can automatically 
e-mail or transfer a downloaded or directly-recorded audio file via FTP .  It also has the ability to 
automatically receive a transcribed document file and to manage it with a link to the 
corresponding audio file. 
 

• Transcription Module 
This is an application for transcriptionists.  The application can notify the transcriptionist of the 
arrival of a new audio file and switch to a smaller screen at the onset for easier transcription.  It 
automatically receives and captures audio files, via e-mail or FTP, for transcription.  It has 
document management capability that can automatically start your word -processor software 
before transcription, and can manage a document with a link to the corresponding audio file.  In 
addition, if the original audio file was received via e-mail or FTP, the application can automatically 
send a document file to a specified destination immediately after transcription has been 
completed. 
 

• System Configuration Program 
This is an application for administrators.  It is used to deploy and manage DSS Player Pro R5 in 
an organization.  System Configuration Program consists of System Customization Program and 
Device Customization Program. 
System Customization Program facilitates installation and updates of modules for end users 
(Dictation Module and Transcription Module), manages application settings for end users 
(Authors and Transcriptionists), and updates firmware management. 
Device Customization Program can customize, import, and export device settings. 
 

• License Manager 
This is an application to manage licenses.  It manages licenses and accounts of the Dictation 
Module and Transcription Module in a workgroup system. 
This application can change each license account by grouping multiple single licenses as a 
multi-license. 

 



10 / 168 
 

1.2 Licenses 
 
To use DSS Player Pro, a license is required.  DSS Player Pro is provided under the following two types of 
licenses: 

• Single License 
This is the license ID, issued with a recorder or foot switch that allows single licensing of DSS 
Player Pro. A recorder license allows the Dictation Module and Transcription Module to be 
installed on a PC.  A foot switch license allows only the Transcription Module to be installed on a 
PC. 

• Multi-license 
This is a combined license ID that groups several single licenses into one license ID for both the 
Dictation Module and Transcription Module.  A multi-license is managed as a floating license. 

• Decoder License 
This is the license for redistribution of DSS and DSS Pro decoders.  A redistribution contract 
allows acquisition of a decoder license ID and redistribution of the decoder.  To enable the 
decoder, the license ID needs to be registered when installing it. 

 

 
The single and other licenses cannot be used. 

 

Purchasing an Initial or Additional Multi-license 

In exchange for multiple single licenses, a multi-license, corresponding to the number of single licenses 
received, can be issued without charge.  
Please contact our support team for details. 
 

Other License Keys 

DSS Player Pro R5 license keys vary depending on the system.  
Use the appropriate license for each system.  
Please contact our support team for information on re-issuance or replacement of a license. 
The following table shows the licensing scheme for DSS Player Pro R5 system configurations. 
 

System Name Required License License Server 

Stand-alone System Dictation Module single license 
Transcription Module single license 

Not required 

 Multi-license*1  
Workgroup System Dictation Module multi-license 

Transcription Module multi-license 
License Manager 

 
*1 : If not using centralized user management with System Configuration Program and sharing 

data only, a stand-alone system can be configured under a multi-license (DSS Player Pro R4.10 
compatible). 
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1.3 Operating Conditions 
 
The following table lists the operating conditions of DSS Player Pro R5. 
 

Item Conditions 

OS Microsoft® Windows® 2000 Professional Operating System SP4 
Microsoft® Windows®XP Professional Edition SP2 / Home Edition SP2 
Microsoft® Windows®XP 64-bit Professional Edition SP2 / Home Edition SP2 
Microsoft® Windows Vista® Ultimate / Enterprise / Business / Home Premium / Home 
Basic 
Microsoft® Windows Vista® Ultimate 64-bit edition / Enterprise 64-bit edition / 
Business 64-bit edition / Home Premium 64-bit edition / Home Basic 64-bit edition 
Microsoft® Windows® 2000 Server Operating System 
Microsoft® Windows® Server 2003 Operating System 
Microsoft® Windows® Server 2003 Operating System x64 edition 

CPU Microsoft® Windows®2000/XP:  Intel Pentium III 500MHz or higher 
Microsoft® Windows Vista® 800MHz or higher 
Microsoft® Windows® Server 2003:  550MHz or more 

Memory Microsoft® Windows®2000/XP:  128MB or more (256MB or more recommended) 
Microsoft® Windows Vista®:  500MB or more (1GB or more recommended) 
Microsoft® Windows® Server 2003:  256MB or more 

HDD 
Space 

70MB or more 
(700MB or more with .NET Framework 2.0 not installed) 

Drive CD-ROM drive installed 
Display Resolution : 800 x 600 pixels or higher 

65,536 colors or more (1,677 colors or more recommended) 
Browser Microsoft® Internet Explorer 6.0 or later (with the latest Service Pack applied) 
USB With the Dictation Module and Transcription Module: 

One or more USB ports available 
Audio Device With the Dictation Module and Transcription Module: 

A Microsoft WDM- or MME-compliant and Windows-compatible sound device 
Others With Citrix Presentation Server: 

Citrix Presentation Server 4.0/4.5 (A Citrix License separately required) 
With Terminal Service: 
Microsoft® Windows® Server 2003 Terminal Service (* A TS CAL license separately 
required) 

Supported 
Languages 

English, French, German, Italian, Spanish, and Russian 

 

 
Installing DSS Player Pro R5 requires the privileges of Administrator. 

 Currently supported OSes are listed on our Web page. For the latest information, please visit 
the Olympus Web site at http://www.olympus-global.com/en/global/. 
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1.4 Devices Connectable to DSS Player Pro Transcription 
Module 
 
DSS Player Pro Transcription Module supports the following Olympus devices. 
 

Device Type Models 

Foot switch RS-27, RS-28 
Compatible device (USB card reader/writer) MAUSB-10, MAUSB-200 

 



13 / 168 
 

1.5 Supported File Formats 
 

Audio File 

The following table lists the file types supported by each function. 
 

Functions Supported File Types (Extensions) 

Playback, import,  
and export 

Non-encrypted files: DS2, DSS, WAV, WMA, and MP3 
Encrypted files: DS2, $DSS, $WAV, $WMA, and $MP3 
In addition to the above, if a codec that works with Microsoft® DirectShow® 
Filter has been installed, an imported file can be played, but we do not 
guarantee proper operations. 

New recording and 
editing 
(At audio capturing) 

Non-encrypted files: DS2, DSS, WAV, WMA, and MP3 
 (Transcription Module cannot configure encryption.) 

 File splitting/joining Non-encrypted files: DS2, DSS, WAV, and WMA 
Encrypted files: DS2 

 

Document Files 

By default, text files (XXX.TXT) and Microsoft Word documents (XXX.DOC) are supported.  
To use another file type, registration is required. 
 

 Configure document type as an optional setting by selecting Folder Design and then 
Attribute.  
→ [Folder Design]-Attribute 
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1.6 Transcription Module Capabilities 
 
The following functions are available: 
 

• While playing back an audio file that was recorded with the recorder on your PC, you can easily transcribe 
the recorded information using a word-processor application (Playback Control Window). 

 

• Reports and meeting summaries can be created (Playback Control Window). 
 

• Memos and ideas can be organized (Dictation Window). 
 

• Recordings can be automatically downloaded from the recorder and backed up on the PC. 
 

• Recordings can be automatically distributed to transcriptionists or other users via email or FTP. 
 

• Prepared documents can be automatically retrieved via email or FTP, and linked to the corresponding 
recording. 
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1.7 Trademarks and Copyrights 
 

• Microsoft, Windows, Windows Media, Windows Server, Outlook, DirectX, Active Directory, and DirectShow 
are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. 

 

• Citrix, ICA (Independent Computing Architecture), MetaFrame, and Program Neighborhood are 
trademarks or registered trademarks of Citrix Systems, Inc. in the United States and/or other countries. 

 

• Crystal Reports and Crystal Enterprise are trademarks or registered trademarks of Business Objects SA. 
and/or its affiliates in the United States and/or other countries. 

 

• Nuance, Dragon, and NaturallySpeaking are trademarks or registered trademarks of Nuance 
Communications Inc. and/or its affiliates in the United States and/or other countries. 

 

• GroupWise, Netware, and Novell are trademarks or registered trademarks of Novell, Inc. and/or its 
affiliates in the United States and/or other countries. 

 

• Lotus Domino and Lotus Notes are trademarks or registered trademarks of IBM Corporation and/or its 
affiliates in the United States and/or other countries. 

 

• Baltech Transponder is a trademark or registered trademark of BALTECH AG and/or its affiliates in the 
United States and/or other countries. 

 

• Inner Media, DynaZip, and Active Delivery are trademarks or registered trademarks of Inner Media Inc. 
and/or its affiliates in the United States and/or other countries. 

 

• SocketTools is a trademark or registered trademark of Catalyst Development Corporation. 
 

• Other company and product names mentioned in this document are trademarks or registered trademarks 
of their respective owners. 
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1.8 How to Use Help 
 
This section describes how to use Help. 
 

Starting Transcription Module Help 

To start Help, perform the following steps. 

 Procedure A 

1. From the Windows Start menu, 
select [All Programs] → [Olympus] → [DSS Player Pro R5] → [Dictation 
Module]. 

 Transcription Module Help will launch. 

 Procedure B 

1. Start the Transcription Module. 

2. Click [F1], or click [Contents] on the Help menu. 

 

Searching with Table of Contents 

The Table of Contents tab groups topics by theme. 

1. Click [Table of Contents]. 

2. Click  for the item that you are interested in. 

3. Click . 

 The topic will be displayed on the right side of the screen. 
 

Searching with Keyword 

The Keyword tab provides an index system.  It can be used to search the keyword list for a desired term, 
or to look up a term by entering its first few letters.  Terms are defined in this section. 

1. Click the Keyword tab. 

2. Enter the first few letters of the term that you are interested in. 

3. Select a topic from the list and click [Display] button. 

 Related topics are will be displayed on the right side of the screen. 
 

Searching 

The Search tab searches for and displays topics that include the entered term.  When doing this, it can 
also identify related terms from across a broad range of Help documents.  Displayed topics are listed in 
the order of relevance. 

1. Click the Search tab. 

2. Type the desired term in the entry field and click [the Search] button. 
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 A list of related topics will be displayed in order of relevance.  

3. Select a topic from the list and click [Display] button. 

 The topic will be displayed on the right side of the screen. 
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22  Fundamentals of DSS Player Pro 
 
This chapter describes the fundamentals of DSS Player Pro. 
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2.1 Audio File Name and Author ID 
 

Audio File Name 

An audio file created with an Olympus recorder is automatically named with eight characters in the format 
below.  Files directly recorded with the Dictation Module also follow the same naming process. 
Author ID (leading four characters) + Job No. (a four-digit number beginning with 1) 
 

Author ID 

The Author ID, which is registered as part of the file name, represents the author of the file.  The 
Dictation Module can register up to ten Author IDs and transfer them to the recorder.  If no Author ID is 
registered, the log-on ID for Windows is used as the Author ID. 
 

Job No. 

The Job No. is a number (1 to 9999) that is decided automatically when a recording is made.  Each time 
an audio file is created, a new number is provided for it.  The Job No., which is an essential number for 
file management, cannot be reset by the user.  Removing batteries from or formatting the memory card 
of the recorder will not reset the Job No. 



20 / 168 
 

2.2 Process and Status 
 
This section provides workflows where users create audio files, complete transcriptions, and delete audio 
files with the DSS Player Pro R5 Stand-alone System and Workgroup System. 
 
Sending an audio file via e-mail or FTP to an external site where it is transcribed: 

 
 
Sharing an audio file on the network and transcribing it: 

 
 
 
DSS Player Pro R5 manages a workflow with the following combinations of processes and statuses. 
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 Process Status 
Audio File 

Editing 

Transcription 
/ Voice 

Recognition 
Location of Audio File 

[1] Record Running - NO  

  Pending OK NO  In the Recording tray 

  Complete OK OK  

[2] Send Waiting OK NO In the Sending box 

  Failed OK NO  

  Complete NO OK In the Sent tray 

[3] Transcription Running NO -  

  Pending NO OK  

  Complete NO NO  

[4] Voice 
Recognition 

Waiting NO NO In the Voice Recognition 
queue 

  Running NO -  

  Pending NO OK  

  Complete NO NO  

[5] Delete Complete NO NO The Recycle Box is cleared 
automatically after a certain 
length of time (Manual 
deletion can also be 
performed) 

 

Operations after Deletion 

With the Stand-alone System and Workgroup System, transcribed audio files are deleted and 
"Process/Status" changes to "Delete/Complete". 
By default, transcribed audio files are automatically moved to the Recycle Box and then deleted 
permanently after a certain length of time.  Files in the Recycle Box can be restored with the Restore 
function, but once deleted permanently, they cannot be recovered..  Make sure that the configuration 
matches your requirements. 
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2.3 How Folders Work 
 
In the Transcription Module, audio files and document files are managed in the Dictation tray and the 
Document tray respectively.  Files are managed in different folders based on which process is being 
performed. Properties for each folder can be configured and centrally managed by an administrator.  
 
There are two types of these folders: shortcut folders and virtual folders. 
Shortcut folders appear to be actual folders, but are really only shortcuts pointing to specified folder paths.  
Shortcuts are automatically created and managed by DSS Player Pro.  Users cannot modify them.  
Shortcut folders can be renamed, but the change is limited to the name only and does not affect the 

shortcut path. When a shortcut folder represents a path in a local PC, it is displayed as  (normal color). 

If the path is over the network, it is displayed as  (green).  
 
A virtual folder does not represent a physical path.  It serves as a container of multiple shortcuts and is 
called "tray". 
 
 

 As for folders managed with Transcription Module, their current settings can be verified 
and modified in the Folder Design dialog box. 

 

2.3.1 Folder Descriptions 

 
This section describes how each folder works. 
 

Folder Name Description 

Dictation Tray This virtual folder, provided as a root folder, manages audio files.  It 
serves as a management container and has no specific function. 

 Download Tray 

FolderA 

～ FolderG 

These shortcut folders download and manage audio files from the 
recorder. 
Audio files in the recorder folders are downloaded into corresponding 
Download folders.  Each Download folder can be configured to a 
selected path. 
If an audio file has Pending status, it is not downloaded into the 
Download folder.  It is downloaded into the Recording folder. 

 Custom Folder 

Sub Folder 

These user-defined shortcut folders manage audio files.  They are 
used as download destination folders and have similar functions to 
Download folders.  Different custom folders can be specified for each 
Author ID. 

 Inbox This shortcut folder stores dictation files received via email or FTP. 

 Outbox 

（ E-mail FTP） 

This virtual folder is the first destination for audio files sent via email or 
FTP. 
Outbox consists of two separately managed virtual folders: E-mail and 
FTP.  Items distributed to Outbox are automatically sent when the 
automatic sending option is selected.  With the manual sending option 
selected, they remain in this folder until the user manually sends them.  
The sending method is configured with option settings for E-mail and 
FTP. 
If items in the E-mail or FTP folder are deleted, their sending operations 
are canceled.  However, since these are virtual items, their deletion 
does not affect the actual audio files. 

 Forwarded This shortcut folder manages the dictations that have been sent. 

Finished This shortcut folder manages items sent from the E-mail 
and FTP folders. 
When an audio file has been sent, the item moves into the 
Sent Items folder. Process/Status of the transferred audio 
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file changes to Send/Complete. Sent Items has the Clean 
attribute, which allows old audio files, after being sent, to 
be cleaned up after a specified length of time.  Sent Items 
is a shortcut folder.  Files in this folder can be moved to 
other folders. 

Backup This shortcut folder backs up audio files when downloaded 
or imported.  If a downloaded or imported audio file is 
lost, it can be restored from the Backup folder.  Since 
repeated backups can consume too much disk space, the 
folder has the Clean attribute for deletion of old backup 
files. 

Recycle Box This shortcut folder temporarily stores old or unnecessary 
audio files.  Its function is similar to that of Recycle Bin in 
Windows.  Deleting audio files in this folder eliminates 
them permanently and makes their restoration 
impossible.  With the General option for a workflow, you 
can select whether audio files in folders are deleted 
permanently or moved to the Recycle Box folder.  Audio 
files in the Recycle Box folder can be restored to their 
original location with the Restore command.  This folder 
has the Clean attribute so that old audio files can be 
automatically deleted. 

Transcriptionist 
Tray 

This is a virtual folder that allows a Transcriptionist to view audio files 
other than those in the Outbox (Email/FTP included), Forwarded, 
Finished, Backup, and Recycle Box folders. 

Document Tray This virtual folder manages document files. With the extensions of 
managed document files registered, using an attribute of the folder, the 
registered document files can be managed in the My Document folder.  
Since this folder is a virtual folder, document files cannot be dropped 
into it. 

 My Document This shortcut folder manages document files.  A document file received 
via email or FTP is stored in this folder.  An existing document file from 
the outside can also be dropped into this folder.  A document file in this 
folder can easily be linked to an audio file. Double-clicking an audio file 
linked to a document file opens the document file. 

 Outbox 

（ E-mail FTP） 

This virtual folder is the first destination for audio files sent via email or 
FTP. 
Outbox consists of two separately managed virtual folders: E-mail and 
FTP.  Items distributed to Outbox are automatically sent when the 
automatic sending option is selected.  With the manual sending option 
selected, they remain in this folder until the user manually sends them.  
The sending method is configured with option settings for E-mail and 
FTP. 
If items in the E-mail or FTP folder are deleted, their sending operations 
are canceled. However, since these are virtual items, their deletion 
does not affect the actual audio files. 

 Sent Items This shortcut folder manages items sent via email and FTP. 
When a document file has been sent, the item moves into the Sent 
Items folder. Process/Status of the transferred document file changes 
to Send/Complete. Sent Items has the Clean attribute, which allows old 
document files, after being sent, to be cleaned up after a specified 
length of time.  Sent Items is a shortcut folder.  Files in this folder can 
be moved to other folders. 
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2.3.2 Folder Functions 

 
This section describes each folder’s capabilities and limitations. 
 

Folder Name Renaming Subfolder 
Creation 

Encryption 
Attribute 

Ownership 
Attribute 

File 
Dropping 

Dictation Tray No No No No No 
 Download Tray 

FolderA～

FolderG 

Yes Yes Yes Yes Yes 

 Custom Folder 

Sub Folder 
Yes Yes Yes Yes Yes 

 Inbox 
No No No No 

OK with 
moving 
only * 

 Outbox 

（ E-mail FTP） 
No No No No No 

 Forwarded No No No No No 
 Finished 

No No No No 
OK with 
moving 
only * 

 Backup No No No No No 
 Recycle Box 

No No No No 
OK with 
moving 
only * 

Document Tray No No No No No 
 My Document Yes No No No Yes 

Outbox 

（ E-mail FTP） 
No No No No No 

Sent Items 
No No No No 

OK with 
moving 
only * 

 
* : Files can be removed from the folder, but cannot be dropped into the folder from the outside. 
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2.4 Worktypes and Option Items 
 
Worktypes and Option Items are IDs, like the Author ID, used to classify recorded files. 
Worktypes are defined as strings, including department names or category names of recorded files.  
Option Items are used to further embed detailed information in a Worktype. 
 
Each recorded file is assigned a pre-defined Worktype.  
For example, with a Worktype associated with a document file template, the template can be opened and 
a document is automatically created in the appropriate format before audio file transcription begins. 
 
DSS Player Pro can register up to ten Worktypes.  Each Worktype can have up to ten Option Items 
registered. 
 
The following diagram shows the relationship between Worktypes and Option Items.  In this diagram, a 
Worktype FAX is associated with two Option Items labeled "TO" and "TITLE". 
 

 
 
An Option Item consists of input data and its label.  Once a label has been registered, its value can be 
entered.  An Option Item is usually input with a barcode. 
 

 Whether to input multiple labels at once with a single barcode scanning or to input them 
separately with a series of barcode scannings can be configured in the Worktype 
Property dialog box. → [Workflow] - [Worktype]. 
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2.5 Direct Record 
 
Direct Record is for recording directly onto the hard disk drive of a PC using a connected recorder or 
DirectRec as a microphone. 
 
In Direct Record, the recording state is managed under two statuses, Pending and Complete, both of 
which are required to finish a recording. 
An audio file with Pending status is saved in the Recording folder, where it can be selected and edited to 
resume recording.  Since the files stored in the Recording folder are in the local PC, a transcriptionist 
cannot open them. 
An audio file with Complete status can always be transcribed.  Once a transcription has begun, it cannot 
be edited.  An audio file with Complete status can be edited until transcription begins. 
 
The Direct Record settings are configured with option settings. 
The following settings can be configured: 

• Recording Format 

• File naming rule for a new dictation 

• Job data 

• Voice comment 

• Start window changes 

• REV button 

• VCVA function 
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2.6 Ownership Attributes 
 
Transcription Module is initially configured to automatically move a transcribed audio file to the Finished 
folder in the module.  This clarifies how many audio files remain for transcription.  However, once an 
audio file has been moved to the Finished folder in Transcription Module, it is invisible to the Dictation 
Module and may be problematic for the Author.  For this reason, the folder has an attribute, based on an 
Author's privilege, to prevent an audio file from moving to the Finished folder in the Transcription Module 
after transcription.  This attribute is called the Ownership attribute.  The Ownership attribute simply 
prevents an audio file from moving to the Finished folder in the Transcription Module once transcription 
has been completed.  A transcriptionist or an author can then move the transcribed file to another folder.  
⇒[Folder Design] - Ownership 
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2.7 Local Mode and Network Mode 
 
A shortcut folder can be modified for any path. 

When a shortcut folder represents a path in a local PC, it is displayed as  (normal color). If the path is 

over the network, it is displayed as  (green).  
With access to the network, files in a shortcut folder assigned a path over the network can be listed.  This 
type of configuration is called the network mode. 
If the download destination is a folder on the network, when a server crashes or no network access is 
available, audio and document files cannot be downloaded. 
 
To avoid this inconvenience, if assigned a network path that is at the time inaccessible, the destination 
folder is automatically switched to a local path, allowing file downloading.  This is called the local mode. 
If a file was downloaded in the local mode, and the system switches back to the network mode, the folders 
for the network and local modes are both displayed and the file downloaded in the local mode is 
automatically moved to the folder for the network mode. 
A file temporarily placed in the local mode can be identified by its icon.  The icon changes back to normal 
when the file moves to the network mode. 
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2.8 Clean 
 
Clean is a folder attribute that deletes files.  Old files can be deleted through one of two methods: by 
directly deleting them, or by moving them to the Recycle Box and then deleting them with the Recycle Box 
delete option. 
Folders with the Clean attribute are listed below.  These folders may contain transcribed audio files. They 
have the Clean attribute to clean up old audio files. 
 
Folders that can be cleaned: 
 

Folder Dictation Module Transcription Module 

Download Tray 

FolderA～ FolderG 

Yes No 

Custom Folder 

Sub Folder 

Yes No 

Sent Items Yes --- 

Finished Yes Yes 

Forwarded --- Yes 

---   Unsupported function 
Yes... Cleanable 
No... Uncleanable 
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2.9 Voice Comment 
 
There are two types of voice comments recorded by an Author with DSS Player Pro R5: instruction 
comments and verbal comments. 
 

Instruction Comments 
Instruction comments can be created only with Direct Record and cannot be composed when making a 
recording with a stand-alone recorder.  Instruction comments are maintained as files separate from an 

audio file and provide a transcriptionist with overall instruction.  A  mark in  column indicates there 
are Instrction comments. 
 

Verbal Comments 
Verbal comments are voice comments embedded into an audio file.  Verbal comments can be recorded 
with supported recorders.  Unlike instruction comments, verbal comments are provided for transcription 
of audio data immediately following the commentary.  For this purpose, verbal comments can be 
recorded at any position in an audio file.  
Instruction comments and verbal comments cannot have index marks inserted. 
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2.10 Storage Mode and Composite Mode 
 
Olympus recorders implement some or all of three standard USB classes of storage, audio, and HID.  To 
provide stable operations, based on their applications, they switch between the following two modes: 
Storage mode, which enables storage class only; and Composite mode, which provides a composite 
device with audio and HID classes (for DS-5000, a composite device with storage, audio, and HID classes). 
When downloading an audio file, the recorder is switched to Storage mode. When using Direct Record, it 
is in Composite mode. DSS Player Pro automatically switches the recorder to Composite mode when the 
Recording screen opens. When DSS Player Pro returns to the Main screen after a recording is completed, 
the recorder is automatically switched back to Storage mode.  Storage and Composite modes can also be 
switched manually. 
Unlike other models, a DS-5000 in Composite mode serves as a composite device with the three classes. 
A DS-5000 in Composite mode does not require mode switching when downloading an audio file or 
performing Direct Record. 

 
Recorder Storage Mode Composite Mode 

DS-5000 Storage Storage + Audio + HID 
DS-4000 Storage Audio + HID 
DS-3300 Storage Audio + HID 
DS-2300 Storage Audio + HID 
DS-50/40/30 Storage Audio + HID 
DS-20/2 Storage Audio + HID 
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2.11 Backing Up 
  
The backup setting of a folder enables an audio file dropped into that folder to be automatically backed up 
to another specified folder. 
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33  Basic Operations 
 
This chapter describes the basic operations of Transcription Module. 
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3.1 Starting and Exiting Transcription Module 
 
To start and exit Transcription Module, perform the following procedures:. 

Starting 
Auto-starting 
Exiting  

 

 
Dictation Module and Transcription Module cannot be started simultaneously on the 
same PC. 

 An option exists to prevent automatic starting.  

 

Starting 

To start Transcription Module, perform the following steps. 

 Procedure A 

1. From the Windows Start menu, 
select [All Programs] → [Olympus DSS Player Pro] → [Transcription Module]. 

 The Transcription Module will start and the Main screen will appear. 

 Procedure B 

1. Double-click a DSS or DSS Pro file through a tool such as Explorer. 

 The Transcription Module will start and the Playback Control screen or Transcribe bar will 
appear. 

 

Auto-starting 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

 The Transcription Module will automatically start and the Main screen, Playback Control 
screen or Transcribe bar  will appear. 

 

Exiting  

 
If you are on the Playback Control screen or Transcribe bar , return to the Main screen and then exit 
Transcription Module. 

 Procedure 

1. Click [Exit] on the File menu on the Main screen. 

Or click the  button in the upper right corner of the Main screen. 
 Transcription Module will close. 
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3.2 Starting and Finishing Transcription 
 
Select an audio file to start transcription. If configured, a specified word processor will open at 
this point. 
 

 Starting conditions of transcription can be optionally configured. 
→[Workflow] → [Transcription] 

 

 Procedure 

1. Select a file in the Content List view and click  on the tool bar. 

Or click [Start Transcription] on the File menu. 
 With “Open word processor in starting transcription” enabled, a specified word processor will 
open at this point. 

 With “Open word processor using document template” enabled, a document template can 
be configured to open based on a specified Author and Worktype. 

 Configuring a Workflow for Transcription. 

2. Select a document template. 

If not using a document template, a specified word processor will open. 

 Registering a document template 

3. Transcribing a file while playing it. 

 Playing an Audio File 

4. Once transcription has been completed, send the created document file to the 
Author. 

 
・Sending an Audio File via E-mail 
・Sending an Audio File via FTP 

5. Delete the transcribed audio file. 

 Automatic deletion can also be configured. 

→Configuring Auto Collection 
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3.3 Downloading Audio Files 
 

Downloading refers to copying a file from a recording device to Transcription Module.  To download a file, 
follow the procedures below.  Downloaded files are stored in the Download tray. 
 

 Download settings are configured in the Workflow dialog box. → [Workflow] - 
[Download] 

 

3.3.1 Downloading All Files 

 
To download all files in the device, perform the following steps. 
 

 
When using a model with the Music folder, executing [Download All] cannot download 
files from the Music folder. 

 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main screen will automatically open. 
The Device window will display the model of the recorder and file information. 

 

 
Connecting or disconnecting the device while the Main screen is open updates device 
information in the Device window. 

 

3. Verify that the device is in Storage mode. 

If in Audio mode, select [Change Device Mode] on the Device menu to switch to 
Storage mode. 

4. Click  in the Device Tree view. 

Or select the device and click [Download All] on the Context menu. 
Or click [Download All] on the Device menu. 

 If multiple devices are connected, the Device Selection dialog box will appear. 
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5. Select the desired device and click [OK] button. 

 All files in every device folder are will be downloaded (copied) into the corresponding A-G 
folders in the Download tray. 
The file naming format is as follows: Recorder user ID (leading four characters) + four-digit 
number. 

 

 
･ Files in the device can be deleted at the same time they are downloaded. 

→[Workflow] - [Download] 
･ Downloading can be automatically started when a device is detected. 

→[Folder Design] - [Auto Download] 
 

3.3.2 Downloading Files into Specified Folders 

 
To download all files into a specified folder at the same time, perform the following steps. 
 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main screen will automatically open. 

3. Right-click the device and select [Download Folder] on the Context menu. 

Or click [Download Folder A (or B-G)] on the Device menu. 
 If multiple devices are connected, the Device Selection dialog box will appear. 

 

  

4. Select the desired device and click [OK] button. 

 Files in a specified folder are downloaded into the corresponding folder in the Download tray. 
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3.3.3 Downloading Specified Files 

 
To download specified files, perform the following steps. 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main screen will automatically open. 

3. Select a folder in the Device Tree view. 

 Files in the folder will be listed in the Content List view. 

4. Select one or more files in the Content List view to be downloaded. 

5. Click [Download Selected File] on the Device menu. 

 The selected files will be downloaded into the corresponding folder (for example, 
folder A to folder A) in the Download tray in the Audio Tree view. If the device has 
no folder, the files will be automatically downloaded into folder A. 
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3.4 Importing Files 
 
Importing is for securing external audio files not managed by Transcription Module so that Transcription 
Module can manage them. 
Supported audio file formats are listed below. These files can also be dragged and dropped with a tool 
such as Explorer. 
 

Audio Files DS2 (DSS Pro), DSS, WMA, WAV, MP3 
Encrypted Files DS2 (DSS Pro), $DSS, $WMA, $WAV, $MP3 

 
Specifying files with formats other than those listed above causes a warning message to appear. However, 
if a codec that works with Microsoft® DirectShow® Filter has been installed, audio files with other formats 
can also be imported. Once imported, file formats can be used by dragging and dropping them each 
subsequent time. 
 

 Procedure 

1. Click  on the tool bar. 

Or click [Import Dictation] on the File menu. 
 The Import File dialog box will appear. 

 

  

2. Select a folder in the File Location field for the file to be imported to. 

Set the import destination folder with the Change button. 
Checking the delete option in the Options box enables the original file to be deleted 
after importing. 

3. Select a file from the list and click [Open]. 

 The specified file will be copied or moved to the selected folder. 
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3.5 Copying or Moving Audio Files 
 
To copy or move an audio file, perform the following procedures. 
 

3.5.1 Copying a File in the Audio Tree View 

 
To copy a file in the Audio Tree view, perform the following steps. 
 

 Procedure 

1. Select a file in the Content List view. 

Clicking [Select All] on the Edit menu selects all files in the List View. 

2. Click  on the tool bar. 

Or click [Copy to Folder] on the Edit menu. 
 The Copy to Folder dialog box will appear. 

 

  

3. Select a destination folder and click [OK]. 

 The selected file will be copied to the specified folder. 
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3.5.2 Moving a File in the Audio Tree View 

 
To move a file in the Audio Tree view, perform the following steps. 
 

 Procedure 

1. Select a file in the Content List view. 

Clicking [Select All] on the Edit menu selects all files in the List View. 

2. Click  on the tool bar. 

Or click [Move to Folder] on the Edit menu. 
 The Move to Folder dialog box will appear. 

 

  

3. Select a destination folder and click [OK]. 

 The selected file will be moved to the specified folder. 
 

3.5.3 Copying a File to a Specified Location 

 
To copy a file to a specified location, perform the following steps. 
 

 Procedure 

1. Select a file in the Content List view. 

Clicking [Select All] on the Edit menu selects all files in the Content List view. 

2. Click  on the tool bar. 
Or click [Copy] on the Edit menu. 

 The specified file will be copied to the clipboard. 

3. Select a destination folder in the Audio File window or specify a folder with a tool 
such as Explorer. 

4. Click  on the tool bar. 
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Or click [Paste] on the Edit menu. 

 The file will be pasted into the specified folder. 
 

3.5.4 Uploading an Audio File to the Device 

 
Uploading is for copying a file in the Content List view for a connected device. 
 

 
File types not supported by the device cannot be uploaded. 

 

 Procedure 

1. Select an audio file in the Content List view and click  on the tool bar. 

Or click [Upload Selected Files] on the Device menu. 
 The Upload dialog box will appear. 

 

  
 

2. Select a destination folder and click [OK]. 

 The selected file will be copied to the specified folder. 
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3.5.5 Exporting a File 

 
This function can export audio and management files to external media. 
A management file is associated with an audio file and contains important information on dictations. 
 

 Procedure 

1. Select a file in the Content List view. 

Clicking [Select All] on the Edit menu selects all files in the List View. 

2. Click  on the tool bar. 

Or click [Export Dictation] on the File menu. 
 The Browse Folder dialog box will appear. 

3. Select a destination folder and click [OK]. 

 The selected audio and management files will be exported to the specified folder. 
 

 
The export function only supports copying to an external location. Specifying a path 
managed by DSS Player Pro results in an error. 
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3.6 Playing an Audio File 
 
This section describes how to play an audio file. 
 

 
･ Clicking [Switch to Playback Control Window] on the View menu hides the Main screen 

and launches the Playback Control screen or Transcribe bar . 
･ Clicking a DSS file with a tool such as Explorer directly launches the Playback Control 

screen and starts playing the file. 
 

3.6.1 Starting and Stopping Playback 

 
Operations like those on a typical tape recorder are available: playback, stop, fast-forwarding, and 
rewinding .  
The Playback Control bar on the Main screen and the Playback Control screen offer the same operations 
during playback. 
 

 Procedure 

1. Select a file to be played in the Content List view on the Main screen. 

Clicking [Switch to Playback Control Window] on the View menu displays the Playback 
Control screen. 

2. Click . 

Or click [Play] on the Context menu. 
Or select a file and click [Play/Stop] on the Play menu. 

 Playback of the file will begin. The Position control (▽) indicates the current playback 
position.  

3. Click  during playback. 

Or click [Play/Stop] on the Play menu. 
 Playback of the file will stop. 

 

 
･ Clicking [Switch to Playback Control Window] on the View menu displays the Playback 

Control screen. 

･ Clicking  again after stopping playback restarts playing from a previous 
position set by a specified length of time configured under [User Setting] - [Playback 
Control] - [Auto backspace]. 

 

Operating with a Foot Switch 

A foot switch (RS-27/28) can be used for playback operation buttons when using the Playback Control bar 
on the Main screen, the Playback Control screen, or the Transcribe bar . 
 

 
Connect the foot switch with the PC via a USB port. A RS-232C connection is not 
available.  
Connecting a foot switch does not start DSS Player automatically. 

 The pedal operations of a foot switch can be customized under →[Device] 
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Function DSS Player Foot Switch Operation 

Playback 
Pressing  

Pressing the LISTEN 
button. 

Stop 
Pressing  

Releasing the LISTEN 
button. 

Start 
fast-forwarding Pressing  

Pressing the FF button. 

Stop 
fast-forwarding Releasing . 

Releasing the FF button.

Start rewinding
Pressing  

Pressing the REW 
button. 

Stop rewinding 
Releasing . 

Releasing the REW 
button. 

 

3.6.2 Shifting the Playback Position 

 
This section describes how to play a file from a specified position. 
 

Shifting to a Desired Position 
Skipping to an Index-marked Position or the Edge of a Verbal Comment 
Operating the Position Control with the Keyboard 

 

Moving to a Desired Position 

 Procedure 

1. Click on a desired position on the Play bar or drag the Position control to the 
desired position. 

 The Position control will move to the specified position. 

  

Skipping to an Index-marked Position or the Edge of a Verbal Comment 

On the Play bar, a red mark ( ) represents an index mark and a light blue bar represents a verbal 
comment. 

 Procedure A 

1. Click on  or . 

Or click [Next Index Mark/Verbal Comment] on the Play menu. 
 The Position control will move to an index mark or the edge of a verbal comment before or 
after the current position. 

 Procedure B 

1. Click  on the tool bar. 

Or click [View All Index Marks] on the Play menu. 
 The View All Index Marks dialog box will appear.  
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2. Select an index mark and click [Skip]. 

  

Moving the Position Control with the Keyboard 

If the Play bar is focused on (surrounded with a dotted line), the Position control can be moved with the 
keyboard. 

 
Keyboard Operations Position Control Behavior 

 Moves to the left 

 Moves to the right 
Home Moves to the beginning of a file 
End Moves to the end of a file 

  
 

3.6.3 Adjusting Playback Conditions 

 
DSS Player can provide better sound quality of recorded sound. Functions can be selected from the 
Playback Control bar on the Main screen, the Playback Control screen, or the Transcribe bar . 
 

 
Depending on administrative settings, some menus are hidden. 

 
Adjusting Volume 
Adjusting Speed 
Suppressing Noise 
Adjusting Tone 
Switching Channels 

Adjusting Volume 

This function is used to adjust the playback volume. 

 Procedure 

1. Drag the slider on the Volume Adjustment control. 

Or click [Up] or [Down] of Volume on the Play menu. 
 The playback volume will adjust. 
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Adjusting Speed. 

Playback speed adjustment allows for slow playback of demanding sound parts and fast playback for 
easier parts. 

 Procedure 

1. Click  or  or drag the slider on the Speed Adjustment control. 

Or click [Up] or [Down] of Speed on the Play menu. 
 Playback speed can be adjusted to nine different levels between 50% and 200% without 
changing the voice pitch (sound pitch). 

 

 
When the playback speed of a stereo-recorded file is set to other than 100％, the audio 
output is monaural. 

  

Suppressing Noise 

Noise cancellation is useful for easier listening of noisy recordings. 

 Procedure 

1. Click  or  or drag the slider on the Noise Cancellation control. 

Or click [OFF] , [1], [2], or [3] of Noise Cancellation on the Play menu. 
 The noise cancellation effect can be adjusted to the following four levels: OFF, 1, 2, and 3. 

 

 
In some recording environments, noise cancellation may not work effectively. In certain 
noise cancellation levels (1-3), the volume level may be too low or the sound quality may 
change. 

  

Adjusting Tone 

An emphasis is placed on the low pitch side when shifting to the B side and on the high pitch side when 
shifting to the T side. In general, shifting to the T side provides better sound quality. 

 Procedure 

1. Click  or  or drag the slider on the Tone Adjustment control. 

Or click [Up] or [Down] of Tone on the Play menu. 

 The tone can be adjusted in increments of 1% from 100% on the B side to 100% on the T 
side. 

  

Switching Channels 

Channel switching may deliver better sound quality. 

 Procedure 

1. Select a channel with [Channel] on the Play menu. 

 Playback sound will be modified. 
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Item Description 

Stereo Plays as stereophonic sound. 
Monaural Plays as monophonic sound. 
Left Plays only the left side track of stereophonic 

sound. 
Right Plays only the right side track of stereophonic 

sound. 
 

 
Channel switching is disabled for monaurally recorded sound. 

  
 

3.6.4 Intro-Scanning 

 
This function sequentially plays only the first five seconds of the files displayed or selected in the Content 
List view.  When all the files have been intro-scanned, a beeping sound is produced. Files with a 
recording time of less than five seconds are played through before the next file is played. Files being 
played back are highlighted in the Content List view. 

 Procedure 

1. Click  on the tool bar on the Main screen. 

Or click [Intro Scan] on the Play menu. 
 Files displayed in the Content List view will be intro-scanned sequentially from a selected file. 
If no file is selected, the Intro Scan will begin with the first file in the list. 

2. Click . 

Or click [STOP] on the Play menu. 
 The Intro Scan will stop. 

 
 

3.6.5 Inserting Index Marks 

 
Index marks can be inserted or deleted with the Main screen, the Playback Control screen at audio 
capturing, or the Transcribe bar at audio capturing. 
 

 
Index marks cannot be inserted into instruction comments. 

 
 

Inserting Index Marks 

To insert an index mark, perform the following steps. 

 Procedure 

1. Select a file in the Content List view. 

 The file will be displayed on the Playback Control bar. 

2. Move the Position control and click  on the tool bar. 

Or click [Insert Index Mark] on the Play menu. 
 An index mark will be inserted at the Position control location. 
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The maximum number of settable index marks is 16 for a DSS file and 32 for a DSS Pro 
file. 
 

Deleting Index Marks 

To delete an index mark, perform the following steps. 

 Procedure A 

1. By clicking  or , align the Position control with the index mark to be 
deleted. 

2. Click  on the tool bar. 

Or click [Delete Index Mark] on the Play menu. 
 The index mark will be deleted. Multiple index marks can be deleted at once. 

 Procedure B 

1. Click [View All Index Marks] on the Play menu. 

 The [View All Index Marks] dialog box will appear. Index marks will be displayed in the 
format of HH.MM.SS. 

  

2. Select an index mark and click [Delete]. 

 The specified index mark will be deleted. Multiple index marks can be deleted at once. 
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3.7 Editing Audio Files 
 
DSS files, DSS Pro files, or WMA files recorded with an Olympus recorder can be edited. 
 

 
Edited files are always saved as new files. 
MP3, WAV, and general WMA files cannot be edited. 

 
The following functions are available. 

 

3.7.1 Capturing a Sound 

 
To create a new audio file, perform the following steps. 
 

 Procedure 

1. Connect a supported digital voice recorder or Directrec to a USB port on the PC. 

2. Select a file and click [Start Audio Capture] on the File menu. 

Or select a file and click  on the tool bar. 
 The Audio Capture dialog box will appear. 

 

  
 

Item Description 

File name Enter the file name for a recorded audio 
file. 

The current login user name's leading 
four characters plus Job No. are initially 

displayed. 
Save Folder Select the folder for saving a recorded 

file. "Folder A" is displayed by default. 
The Download folder or custom folders 

can be selected. 
Format Select the recording format of a file. 

Attribute Select the attributes of a file. 

3. Click the Start button. 

 The Playback Control screen or Transcribe bar with the recording button will be displayed. 

4. Click  to start recording. 
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5. Click . 

 The recording will stop. Clicking  again appends recording to the same file. Recording 
cannot be inserted in the middle of the file. 

6. Click . 

 The file will be saved with the conditions specified in step 2, and the application will then 
return to the Main screen. Completed audio files always have "Recording Finished" status. 

 

3.7.2 Converting the File Format 

 
This function converts an audio file selected in the Content List view into a specified file format. With 
multiple files selected, it converts all of the files into the specified format. 
 

 
With "Format Conversion" enabled in the folder property settings, files in the folder are 
automatically converted into the specified format according to the settings under  

→[Option] - [Actions] - [Format Conversion] 
 

 Procedure 

1. Right-click an audio file in the Content List view, and then click [Convert Dictation 
Setting] on the context menu. 

Or select an audio file and click  on the tool bar. 
Or click [Convert Dictation] on the File menu. 

 The Convert Dictation setting dialog box will appear. 

2. Select a format and attributes and click [Convert]. 

The resulting file will be saved in the same folder. Select whether or not to delete the 
original file after conversion. 

 The file will be converted to and saved as a file with another format, and the original file 
deleted based on the folder property setting. 
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Formats and Attributes of Resulting Files 

 
The following tables list the formats and attributes that can be assigned to resulting files in the Convert 
Dictation dialog box. 

 
Attribute Format 

Codec Sampling 
Frequency 

Quantization Bit 
Rate 

Channel 
(Recording 

Mode) 

WAV PCM 44.10kHz 16bit stereo 
 PCM 44.10kHz 16bit mono 
 PCM 32.00kHz 16bit stereo 
 PCM 32.00kHz 16bit mono 
 PCM 16.00kHz 16bit stereo 
 PCM 16.00kHz 16bit mono 
 PCM 12.00kHz 16bit stereo 
 PCM 12.00kHz 16bit mono 
 PCM 11.025kHz 16bit stereo 
 PCM 11.025kHz 16bit mono 
 PCM 8.00kHz 16bit stereo 
 PCM 8.00kHz 16bit mono 

 
Attribute Format 

Codec Bit Rate Sampling 
Frequency 

Channel 
(Recording 

Mode) 
DSS DSS 6.3kbps 8kHz mono (LP) 
 DSS 13.7kbps 12kHz mono (SP) 
DSS 
Pro 

DSS 6.3kbps 8kHz mono (LP) 

 DSS 13.7kbps 12kHz mono (SP) 
 DSS 28kbps 16kHz mono (QP) 

 
Attribute Format 

Codec Bit Rate Sampling 
Frequency 

Channel 
Constant/Variab

le Bit Rate 
WMA WMA 8kbps 8.00kHz mono CBR 
 WMA 16kbps 22.05kHz mono CBR 
 WMA 32kbps 44.10kHz mono CBR 
 WMA 48kbps 44.10kHz mono CBR 
 WMA 12kbps 8.00kHz stereo CBR 
 WMA 32kbps 22.05kHz stereo CBR 
 WMA 64kbps 44.10kHz stereo CBR 
 WMA 128kbps 44.10kHz stereo CBR 
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3.7.3 Splitting an Audio File in Two 

 
With this function, a DSS file selected in the Content List view can be split into and saved as two files. 
DSS, DSS Pro, WAV, and WMA files can be split. The format and attributes of the original file are preserved 
in the resulting two files. 
 

 Procedure 

1. Select a file in the Content List view and click  on the tool bar. 

Or click [Split] on the File menu. 
 The Split File dialog box will appear. 

 

  
 

Item Description 

Input file name The name and recording time length 
of the file to be split are displayed. 

First half Type in the name of the resulting file 
representing the first half of the 

original file. 
Last half Type in the name of the resulting file 

representing the last half of the 
original file. 

Split position Specify the split position of the file 
with the slider. 

、  
With these buttons, playback of the 

file can be started, stopped, and 
verified. 

Display for 20 
seconds 

Checking this option zooms in on a 
range of 20 seconds centered on the 

slider position, allowing for finer 
position adjustment. 
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2. Type in the names of the two resulting files that will represent the first and last 
halves of the original file, the first name for the first half and the second name for 
the last half. 

 

3. Specify the split position with the slider. 

 

4. Click [Split]. 

 The file will be split at the Position control point and the first and last halves of the file saved 
with the specified names in the original folder. 
By default, the naming format of the two resulting files is "the original file name + _A or _B 
+ extension".  The original file also remains intact. 

 

 
･ File status after splitting is "Recording Finished". 
･ If a file to be split has an instruction comment, the comment is attached to each of 

two resulting files. 
 

3.7.4 Joining Multiple Audio Files 

 
Multiple files selected in the Content List view can be joined together and saved as a single file in the same 
folder. 
DSS, DSS Pro, WAV, and WMA files can be joined. Note that only files with the same format can be joined. 
 

 
Rejoining two split files may result in noise at the point of joining. 

 
･ File status after joining is "Recording Finished". 
･ If files to be joined each have instruction comments, the newly combined file will 

retain all of the instruction comments from the original files. 
 

 Procedure 

1. Select the files to be joined in the Content List view and click  on the tool bar. 

Or click [Join] on the File menu. 
 The Join Files dialog box will appear. 

With  and , playback of the files can be started, stopped, and verified. 
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2. Specify the joining order of the files using the Up and Down buttons. 

3. Type in the name of the resulting combined file in the Output File Name field. 

By default, the naming format of a joined file is "the original file name + _C + 
extension". 

4. Click [Join]. 

 The joined file with the specified file name will be saved in the same folder. 
By default, the naming format of a joined file is "the original file name + _C + extension".  
The original files also remain intact. 

 



56 / 168 
 

3.7.5 Changing the Status of an Audio File 

 
This function changes the status of the currently selected audio file → Process and Status 
 

 Procedure 

1. Select a file in the Content List view and click  on the tool bar. 

Or click [Change Status] on the File menu. 
 The Change Status dialog box will appear. 

 

  
 
The following statuses can be selected. 
 

Recording Finished Recording has been completed. 
Transcription Pending Transcription is underway. 
Transcription Finished Transcription has been completed. 

 

2. Select a status and click [OK]. 

 The status of the selected file will change. 
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3.8 Sending a Document File via E-mail 
 
The E-mail function offers manual transmission via the menu and automatic transmission with periodic 
confirmation. 
 

 
To send a file via email, an email profile needs to be configured in advance 
→ [E-mail/FTP] - [E-mail] 

 
The following two methods are available to send a file via email. 

 

3.8.1 Automatic Transmission via E-mail 

 
With a folder configured to automatically send files via email, the files stored in the folder are saved in 
Outbox and automatically sent to a pre-defined destination at specified intervals. 
 

 To automatically send email, the folder needs to be pre-configured for automatic 
transmission 
→ [Folder Design] - [Actions] 

 
 

Automatically Switching Email Profiles 

When configuring automatic transmission, it is beneficial to set an alternative profile at the same time so 
that if an email cannot be automatically sent with the Auto Send via E-mail setting, the property is 
automatically switched and the email is automatically sent with the Auto Send via E-mail (Alternative) 
setting. 
 

3.8.2 Manual Transmission via Email 

é 
To specify and send files via email, perform the following steps. 
 

 
･ To send a file via email, an email profile needs to be configured in advance 

→ [E-mail/FTP] - [E-mail] 
･ For information on how to register an address, refer to Registering an Email Address.

 

 Procedure 

1. Select a file. 

2. Click  on the tool bar and select a mail profile to be used from the list. 

Or select a mail profile to be used with [Send Via E-mail] on the Tool menu. 
 The Send E-Mail Destination dialog box will appear. 
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3. Click [To], [CC], or [BCC]. 

 The POP/SMTP Address dialog box will appear. 
 

  
 

 With the New Contact button, a new address can be registered  

→ Registering an Email Address 
 

4. Select addresses from the Address Book and click [To:->], [CC:->], and/or 
[BCC:->]. 

5. After completing the configuration, click [OK]. 

 The selected addresses will be displayed in the Send E-Mail Destination dialog box. 
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6. Type in the subject. 

7. Click [Send]. 

 The email will be saved in the Outbox folder. 

8. Select the files configured for sending in the Content List view and click  in the 
Information view. 

 The Information view will display the Mail Entry area. 

9. Type in message text for the mail. 

 

 

10. Select [Send] or [Send and Receive] from Send and Receive on the Tool menu. 

 The emails in the Outbox folder will be sent. 
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3.8.3 Registering Email Addresses 

 
To register an email address, perform the following steps. 
 

 Procedure 

1. Click [New Contact] in the POP/SMTP Address dialog box. 

 

  
 

 The New Contact dialog box will appear. 
 

  

2. Type in a display name (contact name) and its email address in the Display Name 
and E-Mail Address fields respectively, and then click [OK]. 

 The address will be registered in the POP/SMTP Address dialog box. 
Selecting the registered address and clicking [Properties] enables editing of the address. 
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3.9 Sending Document Files via FTP 
 
The FTP sending function offers manual transmission via the menu and automatic transmission with 
periodic confirmation. 
To send a document file via FTP, perform the following steps. Automatic and manual transmission are 
available. 
 

 
To send a file via FTP, an FTP profile needs to be configured in advance 
→ [E-mail/FTP] - [FTP] 

 
 

3.9.1 Automatic Transmission via FTP 

 
With a folder configured for automatic FTP transmission, files stored in the folder are automatically sent 
to a pre-defined destination at regular intervals. 
 

 To automatically send a file via FTP, the folder needs to be pre-configured for automatic 
FTP sending 
→ [Folder Design] - [Actions] 

 

Automatically Switching FTP Profiles 

When configuring automatic transmission, it is beneficial to set an alternative profile at the same time so 
that if a file cannot be automatically sent via FTP with the Auto Send via FTP setting, the property is 
automatically switched and the file is automatically sent via FTP with the Auto Send via FTP (Alternative) 
setting. 
→ [Folder Properties] 
 

 

3.9.2 Manual Transmission via FTP 

 
To manually send a file via FTP, perform the following steps. 
 

 To send a file via FTP, an FTP profile needs to be configured in advance  
→ [E-mail/FTP] - [FTP] 

 Procedure 

1. Select a file. 

2. Click  on the tool bar. 

Or select a mail profile to be used with [Send Via FTP] on the Tool menu. 
 The Set FTP Destination dialog box will appear. 
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3. Click [To]. 

 The FTP Profiles dialog box will appear. 
 

  

4. Select an FTP profile and click [Select]. 

 The FTP address will be displayed in the Set FTP Destination dialog box. 

5. Select whether or not to enable automatic FTP transmission and whether or not to 
display the Check dialog box when sending a file automatically. 

  

6. Click [Send]. 

 The file will be stored in the Outbox folder. With automatic FTP transmission configured in 
the option settings, the file will be sent based on those settings. 

7. Select [Send] or [Send and Receive] from Send and Receive on the Tool menu. 

 The files in the Outbox folder will be sent. 
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3.10 Managing Document Files 
 
Document files are managed in the Document folder. They can easily be registered by dragging and 
dropping with a tool such as Explorer. 
By default, files with "txt" or "doc" extensions are treated as related document files. 
Only configured document files are displayed on the Content List view. To display document files with 
other extensions, the document types need to be configured. 
 

3.10.1 Adding a Managed Document File Type 

 
To add a new type of document file, perform the following steps in which an example of adding a 
document file with a ".WRI" extension to the Document tray is used. 

 Procedure 

1. Click [Option] on the Tool menu. 

 The  Folder Design dialog box will appear. 

2. Click [Document Tray] in the Folder Tree. 

3. Select [Support Document Type] from the Folder Property and click . 

 The Support Document Type dialog box will appear. 
 

4. Type in the extension to be added and click [Add]. 

 Files with the added extension (XXX.WRI) will be displayed in the Document tray. 
 

 

3.10.2 Associating Document Files with Audio Files 

 
To associate a document file with an audio file, perform the following steps. 

 Procedure A 

1. Drag and drop a document file in the Information view onto an audio file in the 
Content List view. 

 The document file will be associated with the audio file. 
The icon and file name of the associated document file will be displayed in the Document 
column of the Content List view. Selecting an audio file in the Content List view will highlight 
the associated document file. 

 

 Procedure B 

1. Select an audio file in the Content List view and click [Associate with Document] 
on the File menu. 

 The File dialog box will appear with My Document as the current folder. 

2. Select a document file and click [OK]. 

 The icon and file name of the associated document file will be displayed in the Document 
column of the Content List view. Selecting an audio file in the Content List view will highlight 
the associated document file. 
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Selecting an audio file and clicking [Open Document] on the File menu causes the 
associated document file to be opened with its associated application. 

 

3.10.3 Dissociating a Document File from an Audio File 

 
To dissociate a document file from an audio file, perform the following steps. 

 Procedure 

1. Select an audio file in the Content List view and click [Remove with Document] on 
the File menu. 

 The audio file will be dissociated from the document file and the icon and file name of the 
document file will be removed from the Document column. 
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3.11 Receiving Audio Files via E-mail 
 
To receive an audio file via email, manual reception via the menu and automatic reception with periodic 
confirmation are provided. 
Received files are stored in Inbox. 
 
The following two methods are available to receive document files. 

 

3.11.1 Automatic Reception via E-mail 

 
With automatic reception pre-configured, emails are automatically received at regular intervals with 
received audio files stored in Inbox. 
 

 
･ To receive a file via email, an email profile needs to be configured in advance 

→ [E-mail/FTP] - [E-mail] 
･ To automatically receive an audio file, pre-configuration is required 

→ [E-mail/FTP] - [Send / Receive] 
 

3.11.2 Manual Reception via E-mail 

 
To manually receive audio files via email, perform the following steps. 
 

 Procedure 

1. Select [Receive] or [Send and Receive] by clicking  on the right side of  on 
the tool bar. 

Or select [Receive] or [Send and Receive] from Send and Receive on the Tool menu. 
 An audio file will be manually received and stored in Inbox. 
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3.12 Receiving Audio Files via FTP 
 
To receive audio files via FTP, manual reception via the menu and automatic reception with periodic 
confirmation are provided. 
Received files are stored in Inbox. 
 
 
The following two methods are available to receive audio files. 
 

3.12.1 Automatic Reception via FTP 

 
With automatic reception pre-configured, audio files are automatically received via FTP at regular 
intervals with received audio files stored in Inbox. 
 

 
･ To receive a file, an FTP profile needs to be configured in advance 

→ [E-mail/FTP] - [FTP] 
･ To automatically receive an audio file, pre-configuration is required 

→ [E-mail/FTP] - [Send / Receive] 
 

3.12.2 Manual Reception via FTP 

 
To manually receive document files via FTP, perform the following steps. 

1. Select [Receive] or [Send and Receive] by clicking  on the right side of  on 
the tool bar. 

Or select [Receive] or [Send and Receive] from Send and Receive on the Tool menu. 
 Audio files will be manually received and stored in Inbox. 
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3.13 Voice Recognition 
 
This function can automatically convert selected audio files into document form using voice recognition 
software. 
 

3.13.1 Setting Conditions for Voice Recognition 

 
To install voice recognition software, perform the following steps. 
 

Installing Voice Recognition Software 

Install Dragon NaturallySpeaking 8.0 or later from Nuance. For instructions on installation, refer to the 
installation guide for Dragon NaturallySpeaking. 
 

 
Dragon NaturallySpeaking only supports the following files. Other types of files are not 
recognized. 
・DSS files recorded in standard mode,  
・WMA files in High Quality mode 
・WAV files saved in PCM format with a sampling frequency of 11.025 kHz or higher. 

 

Conditions for Voice Recognition 

The conditions for voice recognition are configured in the Option Setting dialog box  
→ [Workflow] - [Voice Recognition] 
 
The following settings can be configured: 

• Range of voice recognition 

• Noise Cancellation 

• Automatic playback 
 

3.13.2 Performing Voice Recognition 

 
Voice recognition is applied to a selected file or files. With multiple files selected, it is sequentially 
performed from the top in descending order. One document file is created per audio file. 
 

 

Verbal comment portions of an audio file are not voice-recognized. 

 

 Procedure 

1. Select a file or files in the Content List view and click  on the tool bar. 

Or click [Start Voice Recognition] on the Context menu. 
Or click [Start Voice Recognition] on the File menu. 

 The status of the file will change to "Waiting". When voice recognition begins, it will then 
change to "Recognition Processing". Voice recognition proceeds based on the settings in 
Workflow. 

 
Clicking [end of voice recognition] during voice recognition interrupts the process.  
Selecting a file waiting for voice recognition and clicking [Cancel] removes the file from 
the voice recognition target list. 
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2. With "Between Index Marks" configured, click  again to begin voice 
recognition of the next part. 

 The next part will be written into the same document file.  
 When voice recognition completes, a dialog box for selecting Pending or Finished will appear. 

3. Click [Pending] or [Finished]. 

 With Pending selected, the audio file will remain in the same folder with "Pending" status. 
With Finished selected, it will change to "Finished" status and move to the Finished folder. 
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44  Managing Files and Folders 
 
Folders in the Audio File window and the Device window can be edited according to each application. 

 
The following functions are available. 
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4.1 Editing Folders in the Dictation Tray 
 
To edit a folder in the Dictation tray, follow the procedures below. 
 

 
Dragon NaturallySpeaking supports only the following files. Other types of files are not 
recognized. 
・DSS files recorded in standard mode,  
・WMA files in High Quality mode 
・WAV files saved in PCM format with a sampling frequency of 11.025 kHz or higher. 

 
 

4.1.1 Creating Folders 

 
To create a folder, perform the following steps.  They can also be created by clicking [New] in the  Folder 
Design dialog box. 

 Procedure 

1. Select a folder in the Audio File window and click [New Folder] on the Context 
menu. 

Or click [New Folder] on the File menu. 
 The Create New Folder dialog box will appear. 

 

  

2. Type in a folder name and click [OK]. 

 When the Dictation tray is specified, a custom folder is created at the same tier as the 
Download tray. 

 When a folder in the Download tray is specified, a subfolder is created. 
 

4.1.2 Mounting Folders 

 
This function adds a specified external folder path to the Audio Tree view as a custom folder. As a result, 
it can be managed as a shortcut folder with DSS Player Pro. 
It can also be added with [Add] in the Folder Design dialog box. 

 Procedure 

1. Select the Dictation tray in the Audio File window and click [Add Folder] on the 
context menu. 

Or click [Add Folder] on the File menu. 
 The Browse Folder dialog box will appear. 

2. Select a folder name and click [OK]. 

A new folder can be created by clicking [New Folder]. 
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 The path to the specified folder will be registered as a shortcut folder in the Dictation tray. 
It can be managed with DSS Player Pro like an actual folder. 

4.1.3 Removing Folders 

 
To remove a shortcut folder previously created with [Add Folder], perform the following steps. 
 

 Procedure 

1. Select a shortcut folder in the Audio File window and click [Remove Folder] on the 
context menu. 

Or click [Remove Folder] on the Folder menu. 
 The selected shortcut folder will be removed. 

 

 
Only user-added shortcut folders can be deleted. Only the path to the registered folder 
is removed and the folder itself, including its audio files, is not deleted. 

 
 

4.1.4 Renaming Folders 

 
To rename a folder, perform the following steps. 
 

 
Folders whose context menu does not display [Rename] cannot be renamed. 

 

 Procedure 

1. Select a folder in the Audio File window and click [Rename] on the context menu. 

Or click [Rename Folder] on the Folder menu. 
 The folder name field will become editable. 

2. Type in a folder name and click [Enter]. 

 The folder name will be set. 
 

 
Up to 20 one-byte characters can be used for a folder name (note that for a folder in a 
recorder, the maximum character count is eight). The following one-byte characters are 

unavailable: ¥ / : * ? " < > | 
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4.2 Editing Properties of Audio and Document Files 
 
Audio files and document files contain various types of information as properties. To edit the properties of 
a file, the following methods are available. 
 

4.2.1 Editing in the Properties View 

 
To view the properties of a file, perform the following steps. 

 

 
･ The items displayed in gray cannot be edited. 
･ The Properties view can be customized → Customizing the Properties View 

 

 Procedure 

1. Select a folder in the Audio Tree view or Device Tree view. 

 Files in the folder will be listed in the Content List view. 

2. Select a file in the Content List view. 

 The properties of the selected file will be displayed in the Properties view. 

3. Modify the properties as needed. 

 

4.2.2 In-line Editing 

 
This function can edit the properties of an audio file directly in the Content List view. 
 

 Procedure 

1. Right-click an audio file in the Content List view and select [Edit Item] on the 
context menu. 

Or select the file and click . 
Or click [In-line Edit] on the View menu. 

 For editable items, the entry field turns into either a drop-down list box for selection or an 
editable text box. 

2. Edit the properties as needed. 

 Input data will be immediately reflected. 
 

4.2.3 Editing with the Job Data Dialog Box 

 
This function can edit the job data (Author, Worktype ID, Option Items, and Comments) of a currently 
selected audio file. 
 

 Procedure 

1. Select a file in the Content List view and click [Edit Job Data] on the File menu. 
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 The Edit Job Data dialog box will appear. 

2. Edit the properties as needed. 

3. Click [OK]. 

 

Baltech Transponder 

Baltech's Transponder Reader PAD allows the user to use its sensor inputs as text entries to the Edit Job 
Data dialog box. 

 Procedure 

1. Connect Baltech Transponder to a USB port on the PC. 

2. Select a file and click [Edit Job Data] on the File menu. 

 The Edit Job Data dialog box will appear. 

3. Check [Use Transponder] on the Options menu. 

  
 The Transponder Reader PAD will become available. 

4. Specify the target text entry box with the mouse. 

 

 
If Baltech Transponder Reader PAD is disconnected and then reconnected, check [Use 
Transponder] on the Options menu in step 3 again. 
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4.3 Backing Up Downloaded Audio Files 
 
An audio file can be backed up with one of two methods: automatic backup with backup configuration or 
manual export to external media. 
 

Automatic Backup  

This method allows for automatic backup of audio files with pre-configuration. 

 Procedure 

1. Select a folder to be backed up and click . 

Or click [Options] on the Tool menu and open the Folder Design tab to select a folder. 

2. Enable Backup under Actions in the Folder Properties box. 

 With this setting, each time a file is updated, a backup file is created and stored in the Backup 
folder. 

 

 
Files in the Backup folder can be deleted after a certain length of time. To achieve this, 
set the Purge attribute of the Backup folder. 
→ [Folder Design] - [Actions] - [Purge] 

 
 

Manual Backup 

With operations such as copying, exporting, and dragging and dropping, a file can be manually backed up. 
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4.4 Encrypting and Decrypting Audio Files 
 
Encryption ensures that important files are securely maintained. 
Encryption is applied per file or per folder. 
Encrypted files can be played only when a specified password is entered. 
 

 
About Audio File Encryption 
DSS Player Pro R5's encryption of files other than DSS Pro files works the same as that 
of R4. Since DSS Pro files require DSS Pro-compliant encryption, encrypted DSS Pro 
files cannot be decrypted with DSS Player Pro R4. 

 
With the "Encryption" attribute set to "Yes" for a folder, files in the folder are 
automatically encrypted with "Password" set under "Attribute". With "Password" not 
configured under "Attribute", the Encryption Password dialog box will appear when a file 
is dropped into the folder. 
→ [Folder Design] - [Attributes] - [Encryption/Password] 

 

4.4.1 Encrypting per File 

 
To encrypt a single file, follow the procedure below.  
Encrypting "filename.dss" changes its extension, turning the file name into "filename.$dss". Encrypting a 
DSS Pro file does not affect its extension. 
 

 Procedure 

1. Select an unencrypted document file in the Document List view and click [Encrypt] 
on the context menu. 

Or click  on the standard tool bar. 
Or click [Encrypt] on the File menu. 

 The Encryption Password dialog box will appear. 
 

  
 

2. Type in a password in the Password and Confirm Password fields using 4 to 16 
alphanumeric characters. 

Checking [Set this Password as default] causes the entered password to appear the 
next time a file is encrypted.  

3. Click [Encrypt]. 

 Files in the folder will be encrypted. Clicking [Skip] cancels the encryption. 
 



76 / 168 
 

4.4.2 Encrypting per Folder 

 
With a folder configured for encryption, files in the folder are automatically encrypted with the password 

set for the folder.  An encrypted file is displayed with the Encryption icon ( ) in the Encrypted column 

( ) in the Content List view. 
Encrypting "filename.dss" changes its extension, turning the file name into "filename.$dss". Encrypting a 
DSS Pro file does not affect its extension. 
 

 
When created under an encrypted folder, a subfolder automatically inherits the 
encryption setting from the parent folder. 

 

 Procedure 

1. Select a folder to be encrypted and click . 

Or click [Options] on the Tool menu and open the Folder Design tab to select a folder. 

2. Enable the Encryption attribute in the Folder Properties box. 

3. Click  next to Password in the Folder Properties box. 

 The Encryption Password dialog box will appear. 
 

  

4. Type in a password in the Password and Confirm Password fields using 4 to 16 
alphanumeric characters. 

Checking [Set this Password as default] causes the entered password to appear the 
next time a file is encrypted. 

5. Click [Encrypt]. 

 Files in the folder will be encrypted. Clicking [Skip] cancels the password setting. 
With the folder encrypted, every file within also becomes encrypted, including new 
files stored in the folder. 
 

4.4.3 Decrypting Files 

 
To decrypt an encrypted file, perform the following steps. 
 

 
Files in an encrypted folder cannot be decrypted. 

 

 Procedure 

1. Select an encrypted audio file in the Audio File window and click [Decrypt] on the 
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context menu. 

Or select the audio file and click  on the standard tool bar. 
Or select the audio file and click [Decrypt] on the File menu. 

2. The Decryption Password dialog box will appear. 

  
 

3. Type in the password used for encryption and click [OK]. 

 The file will be decrypted and accesible for playing. 
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4.5 Sorting Audio Files by Author ID 
 
This function can sort audio files downloaded from the recorder by Author ID. Sorting by Author ID 
requires pre-configuration. 
 
With the following settings configured, audio files are sorted by Author ID into their specified folders when 
they are downloaded from the device. 
 

 

4.5.1 Configuring Automatic Sorting of Downloaded Files 

 
This section describes how to define rules on sorting downloaded or imported audio files into different 
folders. 
Audio files are individually sorted into specified folders based on their Author IDs. To configure sorting, 
perform the following steps. 
 

 Procedure 

1. Click [Options] on the Tool menu. 

 The Option Setting dialog box will appear. 

2. Click the Workflow tab. 

 The Option Setting Workflow dialog box will appear. 
 

3. Click [Auto Classification] in the menu tree. 

 The Auto Classification settings box will appear in the right frame. 
 

  
 

4. Click [Add]. 
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The Modify button allows modifications to an exiting rule and the Remove button can 
delete an exiting rule. 

 The Rule Settings dialog box will appear. 

5. In the Rule Settings dialog box, specify the Author ID and the destination folder 
name, and then click [OK]. 

6. If the folder specified in step 5 is encrypted, click [Set the password for 
decryption] to set the decryption password for the folder. 

7. Click [OK]. 

Clicking [Apply] applies the configured rules to the configuration file. 
 

4.5.2 Registering the Author List in the Recorder 

 
To register the Author list, perform the following steps. 

 

 
If required Authors are not registered, register them in the Workflow dialog box. 
→ [Workflow] - [Author] 

 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main screen will automatically launch. 
The Device window will display the model of the recorder and file information. 

 

 
While connecting or disconnecting the device while the Main screen is open, device 
information will be updated in the Device window. 

3. Click  on the Device Tree view. 

Or click [Device Setting] on the Device menu. 
 The Device Setting dialog box for the supported model will appear. 

4. Click [Author List] in the menu tree. 

 The Author List settings will appear in the right frame. 
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5. Check Author IDs to be registered with the recorder, and click [OK]. 

To select an Author on the recorder when making a recording, check [Display the 
Author List at power-on]. 

 The Device Setting dialog box will close. 

6. Click . 

 Author IDs, Priorities, and JobData (Worktypes, Option Items 1-10) will be transferred to 
the device. 
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4.6 Sharing an Audio File with the Author 
 
Shared folders allow for file sharing with Authors. 
This section illustrates how to create a new folder in a custom folder and configure it for sharing. Audio 
files are placed in the shared folder to be shared with the Author. The shared folder is configured with 
access permission to be accessible to both the Author and Transcriptionist. 
 

 
File sharing requires configurations on both the Dictation Module and Transcription 
Module. 

 

 Procedure 

1. Right-click a custom folder in the Audio Tree view and select [New Folder] on the 
context menu. 

 The Create New Folder dialog box will appear. 
 

  

2. Type in the folder name and click [OK]. 

 A new shortcut folder will be created. 

3. Click . 

 The Folder Setting dialog box will appear. 

4. Select the folder created in step 2 and click  next to the Path attribute. 

 The Browse Folder dialog box will appear. 

5. Select a folder and click [OK]. 

Clicking the New Folder button will create a new folder on the specified path. 
 The specified folder will be linked with the shortcut folder created in step 2. 

6. Verify the folder sharing setting configured in step 5. 

Both the Author and Transcriptionist should be able to access the shared folder. 

7. Drag and drop audio files to be shared into the folder created above. 

 Both the Author and Transcriptionist can access the same audio files. 
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4.7 Automatically Deleting Transcribed Audio Files 
 
With this function enabled, transcribed audio files are automatically deleted. 
This function can automatically cleanup and purge transcribed audio files in each folder after a specified 
length of time. 
 
The following procedure describes how to move an audio file to the Recycle Box with the Cleaning setting 
after one-month storage in the Transcription Finished folder, and how to eventually delete it permanently 
after two-week storage in the Recycle Box. 
 

 Procedure 

1. Click [Option] on the Tool menu. 

2. Click the Finished folder in the Folder tree in the  Folder Design dialog box. 

3. Select the "Clean" item and click . 

 The Cleaning Setting dialog box will appear. 

4. Check "Enable Cleaning", select "1 month" for the interval, select "Move To 
Recycle Box" for the option setting, and click [OK]. 

5. Click the Recycle Box folder. 

6. Select the "Purge" item and click . 

 The Purge Setting dialog box will appear. 

7. Check "Enable Purge", select "2 weeks" for the interval, and click [OK]. 
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55  Customizing the Transcription Module 
 
This chapter describes how to make the module easier to use by modifying screen appearance and key 
assignments. 
 
The following functions are available. 
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5.1 Customizing the Work Area 
 
The work area of the Main screen consists of four parts listed in the following table. These views, except 
the Content List view, can be shown or hidden as needed. 
 

Name Hidden Default 
Audio Tree view Yes Shown 
Device Tree view Yes Shown 
Content List view Always shown Always shown 
Information view Yes Hidden 
Properties view Yes Shown 
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5.2 Customizing the Content List View 
 
Displaying files in the Content List view can be customized in various ways. 
The following methods are available. 
 

5.2.1 Interchanging Displayed Columns 

 
To change the order of displayed columns, perform the following steps. 

 Procedure 

1. Select a column name and then drag and drop it. 

 The order of displayed columns will change. 
 

 Changing Displayed Columns for a File 

 

5.2.2 Sorting Displayed Files 

 
To change the order of displayed files, perform the following steps. 

 Procedure 

1. Select a column with [Sort by] on the View menu. 

 Files will be sorted by the selected column in ascending order. 
 

5.2.3 Changing the Columns Displayed in the Content List View 

 
To show or hide the columns in the Content List view, perform the following steps. 
 

 
File name and priority cannot be hidden. 

 

 Procedure A 

1. Right-click on the list box in the Content List view without selecting a file. 

 The list of column headers will be displayed as a context menu. 

2. Click a column to show or hide it. 

 

 Procedure B 

1. Click [Columns to Display] on the View menu. 

 The Columns to Display dialog box will appear. 
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2. Select the Folder type. 

Voice Folder Configures the displayed columns for files in the 
audio file folder except the following three types of 
folders. 

Outbox Configures the displayed columns for Outbox files. 
Sent Items Configures the displayed columns for Sent Items 

files. 
My Document Configures the displayed columns for My 

Document files. 
 

3. Use the [>>] and [<<] buttons to move the columns. 

The columns placed in the Columns to Display box are displayed in the Content List 
view. 
To change the order of displayed columns, use the UP and DOWN buttons. 
Clicking [Reset] returns the displayed columns to the default setting. 

 The screen will close and the display of the Content List view will be updated. 
 

 
・Displayed Property List (Audio File List view) 
・Displayed Property List (Document List view) 
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5.2.4 Filtering Displayed Files 

 
The filtering function for column headers can filter columns to display. 
 

 
・Displayed Property List (Audio File List view) 
・Displayed Property List (Document List view) 

 

 Procedure 

1. Click  in the Content List view. 

Or click [Filter On/Off] on the View menu. 
 The filtering function will be enabled and  will be displayed for each column header. 

When a filtering condition has been set for a column, the button for the column turns to . 
 

  

2. Click  and select conditions from the list box. 

Selecting “All” disables the filter for the current column. 
For the columns whose date and time, number, or length can be specified, the Filters 
Option dialog box will appear when the Option button is pressed. Configure their 
conditions based on the instructions provided. 

 Only the files that meet the configured conditions will be displayed. 
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5.3 Customizing the Properties View 
 
The  (Customization) button can customize the Properties view. 
 

 Procedure 

1. Click  on the Properties view. 

 The Change of a property view dialog box will appear. 
 

  

2. Check or uncheck the boxes to show or hide the corresponding properties. 

The properties can be individually set to be shown or hidden. 
They can also be shown or hidden according to their category. 
Checking [The display of an explanation domain] displays the description area at the 
bottom of the window. 

3. Click [OK]. 

 The settings will be fixed and the dialog box will close. 
 
 



89 / 168 
 

5.4 Assigning Hot Keys 
 
The User Setting dialog box allows for verification and modification of key assignments for commands. 
Key assignments are configured in the User Setting dialog box. 
→ [User Setting] [Keyboard] 
 
The functional scope of an assigned key depends on the Hotkey settings, which are configured with 
[Hotkey On/Off] on the Tool menu. 
With Hotkey set to Off, the commands are executed only when the window is active. 
With Hotkey set to On, the commands are executed regardless of whether or not the window is active. In 
that case, command-assigned keys are enabled even when another screen overlaps the DSS Player Pro 
screen on the display. 
 

 For information on default key assignment for each function, refer to Default Key Assignments.
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66  Option Settings on Operating Conditions 
 
This chapter describes how to configure the operating conditions of DSS Player Pro Transcription Module. 
 
When DSS Player Pro is operated as a Workgroup System, System Configuration Program manages 
users on a per-workgroup basis. The option setting for items with the lock icon  listed in the table below 
are managed by System Configuration Program, forbidding Author modification.  
To modify these items, contact your administrator. 
 

Category Functions 

Folder Design Designs folders used by an Author or Transcriptionist. 

Workflow Configures workflows performed by an Author or Transcriptionist. 

User Settings Configures items related to usability. 

E-mail/FTP Configures email or FTP for users. 

Device Configures devices used by an Author or Transcriptionist. 

Update Configures updates for software or firmware. 
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6.1 Folder Design 
 
This category is provided to customize folders for audio and document file storage . 

Items with the lock icon  can only be enabled or disabled by the administrator. 

 Procedure 

1. Click [Options] on the Tool menu. 

2. Click [Folder Design]. 

 The  Folder Design dialog box will appear. 

3. Select a folder to be configured from the folder tree on the left, and configure its 
settings in the Folder Properties box on the right. 

[OK] : Fixes settings. 
[Cancel] : Exits without modifying settings. 
[Apply] : Enables changes. 

 

 For information on applications and functions of the Dictation tray and 
Document tray, refer to How Folders Work. 

 

6.1.1 Folder Properties 

 
Properties of folders selected from the folder tree are displayed. 
Properties are configured for each folder. 
Configurable properties vary depending on the folder type. 
 

Attributes 
Enabled 
Name 
Path 
Encryption 
Password 
Ownership 
Support Document Type 

Actions 
Auto Download 
Format Conversion 
Auto Send via E-mail 
Auto Send via E-mail (Alternative) 
Auto Send via FTP 
Auto Send via FTP (Alternative) 
Backup 
Cleaning 
Purge 
Notification 

 

 
How to Configure Properties 
Properties can be configured with one of two methods: clicking the [+] 
button for direct configuration or clicking the  button to display a 
dialog where they can be configured. Either way allows for property 
configuration. 
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6.1.2 Attributes 

 
The following attributes of a folder can be configured. 
 

Enabled 
Name 
Path 
Encryption 
Password 
Ownership 
Support Document Type 

 

 Enabled 

This attribute sets whether or not to display folders in the folder tree. 
This setting works with the ON/OFF setting of the checkbox in the folder tree. 
With this attribute set to False (Hidden), folders are not displayed in the application folder tree, and files 
cannot be manipulated (downloaded, imported, moved, or copied) with the folder. 

  

Name 

This attribute sets the folder name. 
It can be entered by clicking the cell. 

  

Path 

This attribute sets the folder path. It can be configured using the Browse for folder dialog box, which is 
displayed by clicking the  button. 

  

Encryption 

With the Encryption attribute set to "Yes", files in the folder are encrypted. Moving the folder does not 
affect the Encryption attribute. 

  

Password 

If the Encryption attribute is enabled, the encryption password for files stored in the folder needs to be 
specified. 
The password is set or modified in the Change Password dialog box, which is displayed by clicking the  
button. 
It can be specified using 4 to 16 one-byte alphanumeric characters. 
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Ownership 

With the Ownership attribute set to "Yes", audio files are not moved to the Transcription Module Finished 
folder even after transcription. 
The Ownership attribute can be set for the Download tray and custom folders, whose subfolders have the 
same Ownership attribute as them. 
 

Ownership 
Auto 

Collection 
Audio files in Transcription Finished 

Yes Moved to the Finished folder in Dictation 
Module.  (set as a rule) 

Yes 

No Not moved. 
Yes Moved to the Finished folder in Transcription 

Module.  (set as a rule) 
No 

No Not moved. 

 

 For the concept of the Ownership attribute, refer to Ownership Attribute. 

  

Support Document Type 

This is an attribute configured for the Document tray. It sets the supported types (extensions) of 
document files. 
The extensions of document files are registered in the Support Document Type dialog box, which is 
displayed by clicking the  button. 
"TXT" and "DOC" are the default extensions. 
Up to 100 extensions can be configured. 

  
 

6.1.3 Actions 

 
The following folder actions can be configured. 
 

Auto Download 
Format Conversion 
Auto Send via E-mail 
Auto Send via E-mail (Alternative) 
Auto Send via FTP 
Auto Send via FTP (Alternative) 
Backup 
Cleaning 
Purge 
Notification 

 

Auto Download 

This option sets whether or not to automatically download audio files from the recorder. 
With this option set to "Yes", audio files are automatically downloaded from various storage media 
detected in the device.  When they have been downloaded successfully, a completion message is 
temporarily displayed. 
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Format Conversion 

This option sets automatic conversion of files stored in the folder. 
 
By clicking the [+] button, format conversion can be configured. 
Enabled  ：Enables or disables auto format conversion. 
Format  ：Selects file format. 
Attribute  ：Selects audio format. 
Original Deletion ：Deletes the original file after conversion. 
These settings can also be configured in the Convet Dictation Settings dialog box, which is displayed by 
clicking the  button. 

 

Auto Send via E-mail 

This option sets whether or not to automatically send files stored in the folder via email. 
 
By clicking the [+] button, automatic transmission via email can be configured. 

Enabled ：Enables or disables automatic transmission via email 
Profile ：Selects a profile for automatic transmission 
TO ：The destination of an email 
CC ：The destinations of copies of an email (addresses disclosed to recipients) 
BCC ：The destinations of copies of an email (addresses not disclosed to recipients) 
Subject ：The title of an email 
Body ：The message of an email 
Prompt ：Shows or hides the confirmation dialog box when a file is automatically sent 
 

• With multiple email profiles configured, the profile selection dialog box appears. 

• With no email profile configured, the confirmation dialog box appears and allows the user to choose to 
create a new email profile. → E-mail / FTP 

 
These settings can also be configured in the Auto Send via E-mail Setting dialog box, which is displayed 
by clicking the  button. 

 

Auto Send via E-mail (Alternative) 

Setting the Enabled attribute to "Yes" enables the alternative setting for "Auto Send via E-mail". 
This profile is used for sending an email when it cannot be sent with the "Auto Send via E-mail" profile. 
If it cannot be sent with either "Auto Send via E-mail" or "Auto Send via E-mail (Alternative)", a warning 
message appears and allows the user to decide which profile to use. 

 

Auto Send via FTP 

This option sets whether or not to automatically send files stored in the folder via FTP. 
 
By clicking the [+] button, automatic sending via FTP can be configured. 

Enabled ：Enables or disables automatic sending via FTP 
Profile ：The profile used for automatic sending 
Prompt ：Shows or hides the confirmation dialog box when a file is automatically sent 

• With multiple FTP profiles configured, the profile selection dialog box appears. 

• With no FTP profile configured, the confirmation dialog box appears and allows the user to choose to 
create a new FTP profile. 
→ E-mail / FTP 

These settings can also be configured in the Auto Send via FTP Setting dialog box, which is displayed by 
clicking the  button. 
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Auto Send via FTP (Alternative) 

Setting the Enabled attribute to "Yes" enables the alternative setting for "Auto Send via FTP". 
This profile is used for sending a file via FTP when it cannot be sent with the "Auto Send via FTP" profile. 
If it cannot be sent with either "Auto Send via FTP" or "Auto Send via FTP (Alternative)", a warning 
message appears and allows the user to decide which profile to use. 

 

Backup 

With "Backup" enabled, files in the folder are backed up to the Backup folder. 

Cleaning 

This option sets the retention period of files in the folder. 
The settings include whether or not to move the files to the Recycle Box and whether or not to delete them 
permanently once the retention period has expired. 

Retention Period : Sets the length of time until cleaning occurs, starting from the moment files 
have been moved to the Finished/Sent Items folder 
Value : 1-99 
Unit : Month(s) / Week(s) / Day(s) 
 

By clicking the [+] button, the cleaning function can be configured. 
Enabled : Enables or disables the cleaning function 
Target : The minimum age of files to which cleaning is applied (Default : 1 month) 
Option : The condition for deleting cleaned files 
 

These settings can also be configured in the Cleaning Settings dialog box, which is displayed by clicking 
the  button. 

 

Purge 

This option is configured for the Backup folder or Recycle Box. With Purge configured for the folder, the 
files in the folder are automatically deleted (purged). 
To configure Purge for the folder, select its checkbox. (Default: unchecked) 
This option sets the length of time until purging files once they have been copied to the Backup folder or 
moved to the Recycle Box. 
Retention Period 

Value : 1-99 
Unit : Month(s) / Week(s) / Day(s) 

 
By clicking the [+] button, the purging function can be configured. 

Enabled : Enables or disables the purging function 
Target : The minimum age of files to which purging is applied (Default : 1 month) 
 

These settings can also be configured in the Purge Settings dialog box, which is displayed by clicking the 
 button. 

 

Notification 

This option sets whether or not to give the user notification when a new file has been stored in the folder. 
The notification is issued when a file is added via downloading, email, or FTP. 
With the option set to "Yes", notification is made according to the notification setting of the Workflow. 
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6.2 Workflow 
 
DSS Player Pro provides Workflow, a configured series of operations when downloading and editing an 
audio file. 

The items with the lock icon  can only be enabled or disabled by the administrator. 

 Procedure 

1. Click [Options] on the Tool menu. 

2. Click [Workflow]. 

 The Workflow dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK] : Fixes settings. 
[Cancel] : Exits without modifying settings. 
[Apply] : Enables changes. 

 

 
 
 

6.2.1 General 

 
This category configures the general settings for a workflow. 

The items with the lock icon  can only be enabled or disabled by the administrator. 
 

Delete Option 
Synchronize DVR time with PC time 
Resolve filename 
Refresh interval 
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Delete Option 

This option selects how to handle an audio file when deleting, using [Delete] on the Edit menu or the 
[Ctrl+D] shortcut keys. 

• With "Move to Recycle Box" selected, a deleted file is moved to the Recycle Box. 

• With "Delete Completely" selected, a deleted file is permanently deleted. 
 

 
･ With "Move to Recycle Box" selected for [Delete], selecting [Shift] + 

[Delete] executes "Delete Completely". With "Delete Completely" 
selected for [Delete], selecting [Shift] + [Delete] executes "Move to 
Recycle Box". 

･ This option can only affect audio files. Deleting a document file always 
executes "Delete Completely", resulting in permanent deletion. 

  
 

Synchronize DVR time with PC time 

This option sets whether or not to automatically synchronize the DVR (recorder) clock setting with the 
time on the PC when the DVR is connected to the PC. 

  

Resolve filename 

This option sets whether or not to rename an audio file when it is downloaded, imported, or dragged and 
dropped. 

• With "Automatic rename" selected, the file is automatically renamed if there is a file with the same name in 
the destination folder. 

• With "Prompt selection of rename or overwrite" selected, the user has the option of overwriting or 
renaming the file if there is a file with the same name in the destination folder. 

  

Refresh interval 

This option configures refreshing of the current folder. 
With "Refresh folders automatically" enabled, the file information displayed in the Content List view is 
periodically refreshed. The refresh interval is configured with "Refresh interval" (1-999 minutes). 

  
 

6.2.2 Download 

 
This category configures operations when an audio file is downloaded. 
The message for display, file naming rule, and deletion criteria when the file is downloaded can be 
configured. 

The items with the lock icon  can only be enabled or disabled by the administrator. 
 

Auto download option 
Advanced download 
Job Data Settings 
Rename 
Delete 

 

Auto download option 

The automatic download option enables the PC to automatically receive audio data from the device after 
detecting it. 
The following settings can be configured only for automatic-download-enabled folders. 
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• With "Do not display the main window" enabled, the application detects the device at startup and 
automatically downloads files from the device without displaying the Main screen. 

• With "Prompt for selecting the file to download" enabled, the dialog box for selecting files to download 
appears when they are downloaded. Only the files in automatic-download-enabled folders are displayed in the 
dialog box. 

  

Advanced download 

This option is used to download audio files to specified folders or folders assigned for each Author ID. 
 

 
This option overrides [Download Folder A-G] on the Folder menu. Use 
[Download All] when downloading the files. 

 
With "Download all dictations to..." enabled, the download method can be selected. 

• With "Specific folder" selected, all audio files in the folders with Folder Properties - Attributes - Enabled set 
to "Yes" are downloaded into a specified folder. 

• With "Folder routed by Author ID" selected, downloaded audio files are sorted into different folders based 
on the rules configured with Auto Classification. 

  

Job Data Settings 

With "Prompt for data every time a file is downloaded" enabled, the Edit Job Data dialog box appears each 
time a file is downloaded. 
Files can be downloaded after both their Worktype ID and Option Item settings are verified. 

  

Rename 

With "Rename downloading files with the set format" enabled, a downloaded file is renamed according to 
a naming rule. 
The naming rule can be configured in the File Name Settings dialog box, which is displayed by clicking the 
Format button. 
Items included in the file name with a separator between them can be defined. 

  

Delete 

This option sets how to delete an audio file in the device after it has been downloaded. 

• With "After downloading file(s), delete the original file(s)" enabled, the original file is deleted after it has 
been downloaded. 

• With "Display confirmation dialog box" enabled, a confirmation dialog box appears before the file can be 
deleted. 

• With "Delete locked DSS file(s)" enabled, even locked files are deleted after importing. 

  
 
 

6.2.3 Import 

 
This category configures operations when an audio file is imported. 
The message for display and the file naming rule when the file is imported can be configured. 

The items with the lock icon  can only be enabled or disabled by the administrator. 
 

Job Data Settings 
Rename 
Delete 
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Job Data Settings 

With "Prompt for data every time a file is downloaded" enabled, the Edit Job Data dialog box appears 
when a file is imported. 
Files can be imported after both their Worktypes and Option Items are verified and configured. 

  

Rename 

With "Rename imported files with the set format" enabled, an imported file is renamed according to a 
naming rule. 
The naming rule can be configured in the File Name Settings dialog box, which is displayed by clicking the 
Format button. 
Items included in a file name with a separator between them can be defined. 

  

Delete 

This option sets how to delete an audio file after it has been imported. 

• With "After downloading file(s), delete the original file(s)" enabled, the original file is deleted after it has 
been imported. 

• With "Display confirmation dialog box" enabled, a confirmation dialog box appears before the file can be 
deleted. 

• With "Delete locked DSS file(s)" enabled, even locked files are deleted after importing. 

  
 

6.2.4 Auto Classification 

 
This category defines the rules on automatically sorting downloaded or imported audio files into different 
folders. 
With Author IDs and their saving folders registered, downloaded or imported audio files are automatically 
sorted by Author ID into corresponding folders. 
 
Up to 100 rules can be defined. 

• To add a rule, configure it in the Rule Settings dialog box, which is displayed by clicking [Add]. 

• To modify a rule, select an Author ID from the list and click [Modify]. Then, modify the rule in the Rule 
Settings dialog box,. 

• To delete a rule, select an Author ID from the list and click [Remove].  
 
 

6.2.5 Notification 

 
This setting displays a Notification window (a pop-up window) when a file has been added to the folder. 
 

Notification of new dictation to the 'Notification folder' with specified interval 
Notification Interval 
Remaining dictations still waiting for transcription 
Notification of high priority dictation only 
Dialog notification 
Sound notification 
Notification of new dictation while Transcription Module is closing 

 

Notification of new dictation to the 'Notification folder' with specified interval 
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With this option enabled, a sound or pop-up window is produced for notification when a file has been 
added to the folder. 
The notification settings can be configured on a per-folder basis with "Set notification folder". 

  

Notification Interval 

This option sets the interval for notification of a new file's arrival (Default : 10 minutes). 
 

Remaining dictations still waiting for transcription 

As long as a newly added audio file has "Recording Finished" status, notification is issued repeatedly, even 
if the user has already been notified of the file's arrival. 

  

Notification of high priority dictation only 

Notification is made only for the arrival of audio files with "High" priority. 
 

Dialog notification 

A pop-up window notifies the user of an audio file's arrival. 
With this option enabled, clicking [Customize] displays the Configure Notification dialog box, where the 
user can configure the display time and the information to be displayed in the pop-up window. 

  

Sound notification 

This option configures the sound for notification. 

 : Plays the audio file for notification. 

 : Stops playback of the audio file for notification. 

  : Sets the name of the audio file for notification. (Default : notify.wav) 

  

Notification of new dictation while Transcription Module is closing 

Notification of a new file's arrival is made even when the Transcription Module has not been started. 
Clicking [Notification Test] initiates the test of Dialog Notification. 

  
 

6.2.6 Routing 

 
This option configures the rules for routing. 
Registered routing rules are listed (Up to 100 rules). 
E-mail and FTP each have their own icon to display. 
 
Sender : Senders of audio files are displayed. 
Destination : Destination paths of audio files are displayed. 
Document Template: Names of document file templates are displayed. 
Receiver  : Receivers of document files are displayed. 
 

• To add a routing rule, configure it in the Routing dialog box, which is displayed by clicking [Add]. 

• To modify a routing rule, select it and click [Modify]. Then, configure the rule in the Routing dialog box. 

• To delete a routing rule, select it and click [Delete]. 
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6.2.7 Author 

 
This category configures Authors. 
Author ID and Priority Level registered here can be selected when creating a new audio file with a function 
such as direct recording. 
 
Up to ten Authors can be registered. 

• To add an Author, register it in the Author Property dialog box, which is displayed by clicking [Add]. 

• To modify an Author, select the Author's ID and click [Modify]. Then, make changes to t the Author Property 
dialog box. 

• To delete an Author, select the Author's ID and click [Delete]. 

• To change the order of Authors, select an Author ID and use the Up and Down buttons to change its 
position. 

 

 
･ An Author ID can be specified using up to 16 characters. 
･ The Priority Level can be configured in the range of 0 to 15. 

 
 

6.2.8 Worktype 

 
Multiple registered Worktype Lists can be transferred into the recorder. 
When recording an audio file with a recorder or direct recording , selecting a Worktype ID enables 
information such as option items to be automatically recorded in the file. 
 
Up to ten Worktype Lists can be registered. 

• To add a Worktype List, configure it in the Worktype Property dialog box, which is displayed by clicking 
[Add]. 

• To modify a Worktype List, select an Author ID and click [Modify]. Then, make changes to the Worktype 
List in the Worktype Property dialog box. 

• To delete a Worktype List, select an Author ID and click [Delete] . 

• To change the order of Worktype Lists, select an Author ID and use the Up and Down buttons to change 
the Worktype List's position. 

 

6.2.9 Voice recognition 

 
This category configures operations when voice recognition is used. 

The items with the lock icon  can only be enabled or disabled by the administrator. 
 

Range 

This option configures the operations of voice recognition. 
With "Entire File" enabled, the whole file is voice-recognized at once. 
With "Between Index Mark" selected, voice recognition is performed for a segment between two adjacent 
index marks. 
 

Others 

With "Use Noise Cancellation" enabled, noise cancellation is applied. 
With "Play automatically when voice recognition is started" enabled, an audio file is automatically played 
when voice recognition is performed. 
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6.2.10 Transcription 

 
This category configures the operations for when transcription is started. 
With “Open word processor in starting transcription” enabled, a specified word processor is started when 
starting transcription. 
With "Open specified word processor" enabled, transcription is started with a specified word processor. 
With “Open word processor using document template” enabled, a document template can be configured 
to be opened based on a configured Author (ID) and Worktype. (Up to 100 templates can be registered.) 
 

• To add a document template, configure it in the Template Association dialog box, which is displayed by 
clicking [Add]. 

• To modify a document template, select it and click [Modify]. Then, make changes to the template in the 
Template Association dialog box. 

• To delete a document template, select it and click [Remove]. 
 

6.2.11 Receive 

 
This category configures the settings for automatically receiving audio files. 
E-mail/FTP profiles, audio file types, receipt notifications, and expiration of audio file for transcription can 
be configured. 

Items with the lock icon  can only be enabled or disabled by the administrator. 
 

Received dictation 
Rename 
Auto collection 
Activate automatic collection function 

 

Received dictation 

• With "E-mail" enabled, audio files can be received via email. 
By default, the currently used email profile is displayed.  

• An E-mail or FTP profile can be created and modified by clicking "Change the profile". 
→ E-mail / FTP 

• With "FTP" enabled, audio files can be received via FTP. 

• Multiple FTP sites can be registered. They are added to the list after registration. 
An audio file can be received via FTP sites with the appropriate checkbox selected. 

• An audio file can be received when it has one of the extensions enabled in the "Select the extension of 
dictation file to receive" list. 

• The document type can be changed in the Support Document Type dialog box, which is displayed by 
clicking "Add/Remove support document type". 

  

Rename 

With "Rename received dictation with the set format" enabled, an audio file is renamed according to a 
naming rule when it is received. 
The naming rule can be configured in the File Name Settings dialog box, which is displayed by clicking 
[Format]. 
Items to be included in the file name with a separator between them can be defined. 
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Auto collection 

This function moves audio files with "Transcription finished" status into a specified folder in the Download 
tray or a custom folder. Using this option in combination with the Ownership attribute, the folder for 
saving audio files can be changed. 

The items with the lock icon  can only be enabled or disabled by the administrator. 

  

Activate automatic collection function 

With this option enabled, audio files with "Transcription finished" status are moved to a specified folder. 
Either of the following two methods is available: 

• Moving files to the Finished folder. 

• Moving files to Author ID-specific folders according to a pre-defined rule. 
 
To define the rule, perform the following tasks: 

• To add a rule, configure it in the Rule Settings dialog box, which is displayed by clicking [Add]. 

• To modify a rule, select it and click [Modify]. Then, make changes to the rule in the Rule Settings dialog 
box. 

• To delete a rule, select it and click [Remove]. 
 
The Ownership attribute can be set for the Download tray and custom folders, whose subfolders also have 
the same Ownership attribute. 
 
Using this attribute in combination with Auto Collection, audio files with "Transcription Finished" status 
can be automatically moved to the Finished folder. 
 

Ownership Auto Collection Audio files in Transcription Finished 

Yes Yes Moved to the Finished folder in Dictation Module.  (set 
as a rule) 

 No Not moved. 
No Yes Moved to the Finished folder in Transcription Module.  

(set as a rule) 
 No Not moved. 
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6.3 User Settings 
 
This category provides user-customized settings for using Transcription Module. 

Items with the lock icon  can only be enabled or disabled by the administrator. 

 Procedure 

1. Click [Options] on the Tool menu. 

2. Click [User Settings]. 

 The User Settings dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK] : Fixes settings. 
[Cancel] : Exits without modifying settings. 
[Apply] : Enables changes. 

 

 
 

6.3.1 General 

 
This category configures general settings for users. 
 

Language selection 

This option selects the displayed language used by the application. 
If the setting has been modified, it comes into effect only after the application is restarted. 
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Dictation color 

The display colors for audio file listing can be configured based on the status of each file. 
 

Dictation Type Default Color Font Default 

High Priority (Back color) Light Salmon - DS500001.ds2 
New (Recording Finished) Black Bold DS500001.ds2 
In progress (Transcription In progress) Black - DS500001.ds2 
Pending (Transcription Pending) Olive - DS500001.ds2 
Finished (Transcription Finished) Silver Italics DS500001.ds2 

 
The display colors for audio file listing can be configured based on the status of each files. 
 

• The colors can be selected from the drop-down list. 

• By clicking [Custom], the color can be customized and added as a new color to the drop-down list. 

• Clicking [Reset] returns display colors to default. 
 

6.3.2 Keyboard 

 
Specific functions can be assigned to the keys on the keyboard. 

Items with the lock icon  can only be enabled or disabled by the administrator. 
 

Category 

Selecting a category from the category list displays the command/key assignment list in the selected 
category. 

• General 

• Playback Control 
 

New Key 

• To add a key assignment, select a command with no key assigned, specify a key in the New Key box using 
the keyboard, and click [Assign]. [Alt], [Shift], [Ctrl], and any other key can be combined. 

• To modify a key assignment, select a command to be modified, specify another key in the New Key box 
using the keyboard, and click [Assign]. 

• To delete a key assignment, select a command with a key assigned, and click [Remove]. 

• To return key assignments to default, click [Reset All]. 
 

 For information on default key assignments, refer to Default Key 
Assignments. 

 

Current Assignment 

If the keys entered in the New Key box have already been assigned, the currently assigned commands are 
displayed. 
 

 For information on default key assignments, refer to Default Key 
Assignments. 
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6.3.3 Playback Control 

 
This category configures the settings for audio playback. 

Items with the lock icon  can only be enabled or disabled by the administrator. 
 

Control Indication 
Auto backspace 
Winding speed 
Activate to be able to hear your recording during CUE/REVIEW 

 

Control Indication 

This option controls the display switching of controls as follows: 

• Shows/Hides the Speed control (Default : Shown) 

• Shows/Hides the Noise Cancellation control (Default : Shown) 

• Shows/Hides the Tone control (Default : Hidden) 

• Shows/Hides the Level Meter control (Default : Shown) 

  

Auto backspace 

This option sets the time period of Auto backspace in the range of 0.0 to 5.0 seconds in 0.1-second 
increments. 
 
The following settings are configured with [User Setting] - Transcribe bar. 

 

• Display mode Displays the setting screen for the Transcribe bar. 

• Length/Remaining time indication Displays the setting screen for the Transcribe bar. 

• Always on top Displays the setting screen for the Transcribe bar. 

  

Winding speed 

The feed amounts of CUE/REVIEW and FF/REW can be configured in four levels. 
The horizontal axis represents the length of time that has elapsed since beginning. (3 seconds minimum, 
60 seconds maximum) 
The vertical axis represents the scaling factor relative to the standard playback speed. (1.5x minimum, 
50x maximum) 
Click one of the four levels and adjust the scaling factor to the desired level. 
Note that it cannot be adjusted to levels less or equal to the scaling factor at the previous level. 
To make an adjustment, select the box displayed for each level. 

• The elapsed time can be adjusted using the [←] and [→] buttons. 

• The playback scaling factor can be adjusted using the [↑] and [↓] buttons. 

  

Enable Listenable Playback at CUE/REVIEW 

A typical QUE operation thins out audio data for playback. With this option enabled, however, the Speed 
control is used to provide continuous playback without thinning out sound data when 1.5x or 2.0x is 
selected. 
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6.3.4 Transcribe bar 

 
This category configures the settings of the Transcribe bar. 

Items with the lock icon  can only be enabled or disabled by the administrator. 
 

Display Mode 
Length / Remain time indication 
Always on top 
Button Customization 

 

Display Mode 

This option switches the initial mode for a transcription. 
It can be selected from "Standard view" (Playback Control screen) or "Transcribe bar". 

Length / Remain time indication 

This option switches the displayed information between the played time length and remaining time 
length. 

  

Always on top 

With "Always on top Playback control/Transcribe bar" enabled, the Playback Control screen or Transcribe 
bar is displayed as the foreground window. 
 

 
This setting is not applied to the Playback Control bar on the Main window. 

  

Button Customization 

This option configures the buttons to be displayed on the Transcribe bar. 

• To add a button, select it from "Non Display Button" (on the left) and click [Add]. 

• To hide a button, select it from "Display Button" (on the right) and click [Remove]. 

• To return the button display settings to default, click [Reset]. 

• To change the order of displayed buttons, select a button to be moved and use the Up and Down buttons 
to change its position. 

 

 
Displayed button customization is available only for the Transcribe bar. 
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6.4 E-mail/FTP 
 
This category configures email profile and FTP profiles. 

Items with the lock icon  can only be enabled or disabled by the administrator. 

 Procedure 

1. Click [Options] on the Tool menu. 

2. Click [E-mail/FTP]. 

 The E-mail/FTP dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK] : Fixes settings. 
[Cancel] : Exits without modifying settings. 
[Apply] : Enables changes. 

 

 
 

6.4.1 E-mail 

 
This category can register and modify email profiles.  Up to 100 profiles can be registered. 
DSS Player Pro R5 supports the following sending/receiving protocols: 

• Internet E-mail (POP3/SMTP) 

• IMAP 

• Microsoft Outlook 

• Novell GroupWise 

• Lotus Notes 

• Extended MAPI 
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Selecting an E-mail Profile 

If some profiles have already been registered, select a profile for sending and receiving emails from the 
[Default Profile] drop-down list. 

  

Registering an E-mail Profile 

To register a new email profile, perform the following steps. 

 Procedure 

1. Click [Add]. 

 The E-Mail Settings (Select) dialog box will appear. 

2. Select an email sending/receiving protocol and click [Next]. 

If "Microsoft Outlook" has been selected, the following settings are not necessary. Exit the 
setting procedure. 

Otherwise, the setting dialog box for the selected email profile will appear. 
 

• Internet E-mail (POP3/SMTP) →E-mail Settings (POP/SMTP) Dialog Box 

• IMAP →E-mail Settings (IMAP) Dialog Box 

• Novell GroupWise →E-mail Settings (GroupWise) Dialog Box 

• Lotus Notes →E-mail Settings (Lotus Notes) Dialog Box 

• Extended MAPI →E-mail Settings (Extend MAPI) Dialog Box 

3. Configure settings. 

Advanced settings such as port settings and SSL can be configured only when using Internet 
email (POP3/SMTP) and IMAP protocols. To configure these settings, click [More setting]. 

 

• Internet E-mail (POP3/SMTP) →Advanced Settings (POP/SMTP) Dialog Box 

• IMAP →Advanced Settings (IMAP) Dialog Box 

4. When the configuration has been completed, click [Finish]. 

 
For more information on email settings, contact your service provider or 
system administrator. 

  

Modifying a Profile 

To modify an email profile, select it and click [Modify]. Then, make changes to the profile in the dialog box. 
The displayed dialog box varies depending on the selected email profile. 

 

• Internet E-mail (POP3/SMTP) →E-mail Settings (POP/SMTP) Dialog Box 

• IMAP →E-mail Settings (IMAP) Dialog Box 

• Novell GroupWise →E-mail Settings (GroupWise) Dialog Box 

• Lotus Notes →E-mail Settings (Lotus Notes) Dialog Box 

• Extended MAPI →E-mail Settings (Extend MAPI) Dialog Box 

  

Deleting a Profile 

To delete a profile, select it from the [Default Profile] drop-down list and click [Remove]. 
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Attachment 

With this option enabled, the upper limit for the total size of files attached to an email to be sent can be 
configured. If the limit is exceeded, a separate email is created to accommodate the excess. The upper 
limit can be set in increments of 1MB in the range of 1 to 100MB. 

  
 

6.4.2 FTP 

 
This category configures an FTP profile. 

Items with the lock icon  can only be enabled or disabled by the administrator. 
 

FTP Profile 

Registered FTP profiles are listed. Up to 100 FTP profiles can be registered. 
With multiple FTP profiles registered, files can be sent to and received from registered multiple FTP sites 
via FTP. 

• To add an FTP profile, configure it in the FTP Settings dialog box, which is displayed by clicking [Add]. 

• To modify an FTP profile, select it and click [Modify]. Then, make changes to the profile in the FTP Settings 
dialog box. 

• To delete an FTP profile, select it and click [Remove]. 
 

6.4.3 Send/Receive 

 
This category configures the sending and receiving settings of email and FTP. 
Files are sent and received via email or FTP typically when the [Send and Receive] button on the module 
is clicked. They can also be automatically sent and received at regular intervals. 

Items with the lock icon  can only be enabled or disabled by the administrator. 
 

Send Interval 

With this option enabled, audio files in Outbox are detected and automatically sent. 

• With "Immediately Send" enabled, audio files moved to Outbox are sent immediately. 

• With the sending interval configured, audio files in Outbox are detected and automatically sent. 

• The sending interval can be set in the range of 1 to 999 minutes (Default: 10 minutes). 
 

Receive Interval 

With this option enabled, files are automatically received at regular receiving intervals. 
The receiving interval can be set in the range of 1 to 999 minutes (Default: 10 minutes). 
 

Sending a File 

• With "With Management File" selected, an audio file, management file, and instruction comment file (if 
present) are all sent. 

• With "Without Management File" selected, only an audio file and instruction comment file (if present) are 
sent.  Their management file is not sent. 
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6.4.4 Proxy 

 
This category configures a proxy. 

Items with the lock icon  can only be enabled or disabled by the administrator. 
 

• With "Use Internet Explorer's settings" selected, the application accesses the same proxy server as the 
one used by Internet Explorer. 

• With "Don't use the proxy server" selected, no proxy server is configured. 

• With "Use this proxy server" selected, the module accesses a proxy server with a specified address and 
port number. 
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6.5 Device 
 
The device configuration can customize the pedals of RS-27/28 (foot switches). 
 
 

 Procedure 

1. Click [Options] on the Tool menu. 

2. Click [Device]. 

 The Device dialog box will appear.  
 

  

3. Select functions for the Left (FF), Center (LISTEN), and Right (REW) pedals. 

Some foot switches have no "FF", "LISTEN", or "REW" printings on their pedals. 
 
[OK] : Fixes settings. 
[Cancel] : Exits without modifying settings. 
[Apply] : Enables changes. 

 

Pedal Customize 

 

Item Functions Default 

Pedal Customize Assigns functions to the foot pedal.  
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6.6 Update 
 
This category configures whether or not to check for the latest Updates. 
 

 Procedure 

1. Click [Options] on the Tool menu. 

2. Click [Update]. 

 The Update dialog box will appear. 
 

  

3. To configure automatic checking, check [Check for updates automatically] and set 
[Check Interval]. 

4. To check for Updates immediately, click [Check now]. 

5. Click [OK]. 

 The settings will be confirmed. 
 
[OK] : Fixes settings. 
[Cancel] : Exits without modifying settings. 
[Apply] : Enables changes. 

 

Transcription Module 

 
To automatically check for the latest Updates, enable "Check for updates automatically" and configure 
"check interval". 
With automatic updating enabled, the Olympus download server is checked for update data at configured 
intervals. 
When a newer version than the currently installed one is detected, a confirmation dialog box for 
upgrading appears. If upgrading is selected, the data is downloaded from the server and then updating of 
Transcription Module begins. 
If a proxy server needs to be configured, click [Proxy Settings] and configure the address and port 
number of the server. 
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77  Troubleshooting 
 
This chapter describes how to solve problems with Transcription Module. 
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7.1 The System Remains Silent 
 
If no sound can be produced, verify the following items. 

Recorder Connection 

Check that the device is connected to your PC and powered ON. 
 

Speakers 

Check that the speaker volume is not set to the minimum level. 
 

Sound Card 

Check whether your sound card features a manual volume control; if it does, try turning up the volume. 
 

Playback Volume 

To check this, perform the following steps. 

 Procedure 

1. Click [Settings] - [Control Panel] from the Start menu. 

2. Select [Sounds and Multimedia] - [Audio] and then click [Master]. 

3. Check that the volume of [Master] and [Wave] are not set to the minimum level 
and that [Mute] is not selected. (Play WAV File) 
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7.2 DVR Is Not Recognized 
 
If the recorder connected to the PC is not recognized, verify the following items. 

 Procedure 

1. After connecting the recorder to your PC using an USB cable, check that the LCD 
display of the Digital Voice Recorder shows "REMOTE". 

2. If "REMOTE" is not displayed, remove the USB cable from the recorder and check 
that the stop mode and hold switch are not enabled. 

3. Reconnect the USB cable to the recorder and check that the LCD display shows 
"REMOTE". 

4. If the LCD display still does not show "REMOTE", the communication driver may 
not be working properly. In such cases, check Communication Driver Problem. 
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7.3 Installing to a Network Folder 
 
If installed with a local network folder specified as the installation destination, the DSS Player Pro 
(Dictation Module, Transcription Module) on the local network cannot be started with the standard 
settings due to CAS (Code Access Security) in .NET Framework. 
 
.NET Framework 2.0 Configuration can configure CAS (Code Access Security) to enable the module to 
start from the network folder. 
 
To configure CAS, perform the following steps. 

 Procedure 

1. Select [Control Panel] - [Management Tools] from the Windows Start menu and 
then start .NET Framework 2.0 Configuration. 

2. Click the Console Root tree and select [.NET Framework 2.0 Configuration] - [My 
Computer] - [Runtime Security Policy] - [Machine] - [Code Group] - [All_Code]. 

3. Select [New] on the right-click menu to open the Code Group dialog box. 

  

4. Enter data following the wizard. 

• New code group name :  (Ex. DSS Player Pro) 

• Code group condition : URL 

• URL : Installation destination on the local network (Ex. file://ShareServer/Shared Program/*) 

• Access permission set : FullTrust 

5. After configuring CAS, start Dictation Module or Transcription Module for 
verification. 



118 / 168 
 

7.4 Updating 
 
It is recommended to keep the software up-to-date for efficient use. 
To check for the latest updates for Transcription Module, perform the following steps. 
 

 Procedure 

1. Click [Check for Update] on the Help menu. 

The Olympus download server will be checked for updates. 
When a version newer than the currently installed one is detected, a confirmation 
dialog box for upgrading will appear.  

2. Select upgrading. 

 The data will be downloaded from the server and updating of Transcription Module will 
begin. 

 
 



119 / 168 
 

7.5 Support Contacts 
 

For Purchasing License Keys 

To purchase the following license keys, please contact your dealer or distributor. 
 

• Dictation Module multi-license key 

• Transcription Module multi-license key 
  

For Asking about Malfunctioning 

When submitting a query, the information below needs to be provided to our support staff along with the 
details of your problem. Please keep the following data handy. 

• Type of PC (manufacturer and model) 

• Amount of memory 

• Hard disk space 

• Name and version of the OS 

• Connected peripheral devices 
 

For assistance in solving a problem such as a malfunction, please contact your dealer or distributor. 
Please note that it may take some time to answer your query, depending on our investigations. 

 

Other Support 

Various types of information including product specifications, PC connections, support for OSes, and FAQs 
is available on our Web site. For the latest information, please visit the Olympus Web site at 
http://www.olympus-global.com/en/global/ 
 

 
These descriptions are subject to change. 
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88  Appendix 
 
The appendix provides a collection of related information. 
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8.1 Names and Functions of Screen Components 
  
This section describes the names and functions of the components comprising the three screens of DSS 
Player Pro Transcription Module. 
 
 

Names and Functions of the Main Screen Components 

 
This is the main screen of Transcription Module. This screen is used to organize and play files. The 
Recording screen and Playback Control screen are launched via the Main screen. 
The names and functions of the Main screen components are described here. 

 

 Title Bar 
Displays the standard Windows title 
bar. 

 Content List View 
Lists audio or document files in the 
folder selected in the Audio File window 
or Device window. 

 Menu Bar 
Displays the menu used with 
Dictation Module. 

 Information View 
Displayed by clicking [Restore] in the 
Content List view. This view displays 
the information on content in the 
Content List view, including the content 
of document files and messages of a 
sent email. 

 Tool Bar 
Displays the three groups of tool bar 
buttons - the Standard, Edit, and 
E-mail/FTP groups. Displayed 
buttons vary depending on the 
settings.  Dragging a tool bar button 
with the [Alt] key pressed can change 

 Properties View 
Displays the properties of the chosen 
file or folder. 
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the display order of the buttons. 
Right-clicking the tool bar displays 
the context menu, which can be used 
to show or hide buttons. 

 Playback Control Bar 
Used to play audio files selected in 
the Content List view. The Playback 
Control bar is similar to the Playback 
Control screen. 

 

 Audio Tree View 
Displays various folders storing audio 
and document files managed by 
Dictation Module. The organization 
and properties of the folders can be 
configured based on user needs.  
Selecting a folder displays the audio 
and document files in the folder in the 
Content List view. 

 

 Device Tree View 
Displays folders in connected devices 
and cards. Selecting a folder displays 
the audio files in the folder in the 
Content List view. 

 

Status Bar 
Displays the following information. 

First Area (Operating state 
display) 
Displays the current operating state. In 
the halt condition, the number of 
contents listed in the Content List view 
and the number of selected contents 
among them are displayed. 

Second Area (Icon display) 
Displays how files are being 
automatically sent via email or FTP.  
Double-clicking this area with an icon 
displayed shows the Status dialog box, 
where you can see the progress of 
transmission. When an error occurs, an 
icon appears. By double-clicking the 
icon, the details of the error can be 
checked. 

Third Area 
Displays Author ID. If no Author ID has 
been registered, the Windows logon ID 
is displayed. 
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Names and Functions of Playback Control Screen Components 

 
The names and functions of the Playback Control screen components are described here. 
The Playback Control screen is displayed by clicking [Switch to Playback Control Window] on the View 
menu on the Main screen. This screen is specialized for playing files. It is used to perform such tasks as 
writing a document while listening to a recorded file. Exiting the screen brings the user back to the Main 
screen. 
 

 

 Title Bar 
Displays the name of the file 
currently being played and the name 
of the folder in which the file is 
stored. 

 

 

 Playback 
Position/Recording Time Length 
Displayed on the immediate right of the 
Play bar in the format of HH:MM:SS. 
The playback position of a file is 
displayed in blue, and the total 
recording time length is displayed in 
white. 

  Timescale control 
Displays the timescale of the Play bar. 
The time frame can be changed in the 
range of one-minute width to the 
full-scale. Clicking  or  can change 
the timescale. 

  Volume Adjustment 
Control 
Allows for the adjustment of output 
sound volume. This function is not 
available with an older sound board 
that does not have electronic volume 
adjustment capability. In that case, 
adjust the volume manually. 

 

 Audio Output Display 
Displays the current state of audio 
playback. In the case of a monaural 
recording, the L and R outputs are 
displayed at the same height. 

 Control Panel 

 Priority Button 
This mark indicates the priority of a 
file. A red mark means that the file is 
assigned high priority. 

 Audio/Instruction 
Comment Mode Switching 
Button 
Switches between audio playback 
and Instruction Comment playback. 
In Instruction Comment mode, the 
icon turns to green and the Play bar is 
surrounded by a green line. 

 Information Button 
Clicking this button displays property 
information of a file. The Main screen 
does not have this button. 

 Switch Input Device 
Button 
Pressing this button displays the 
Select Input Device dialog box, 
enabling the user to select an input 
device. 

 User Setting Button 
Clicking this button displayes User 
Setting dialog box. Playback 
condition and Transcribe Bar setting 
can be changed. 

 Transcribe Bar Button 
Switches Playback Control Screen to 
Transcribe Bar. 

 

 Playback Speed 
Adjustment Control 
Clicking  and  or dragging the 
slider can adjust the playback speed 
without changing the voice pitch 
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(sound pitch). 

 

 Noise Cancellation Control 
Clicking  and  or dragging the 
slider can adjust noise cancellation in 
four levels of 0, 1, 2, and 3. 

 Show Status Bar Button 
Shows or hides the status bar.  The 
Main screen does not have this 
button. 

Pl
ay Bar and Position Slider 
Graphically displays which part of the 
current file is being played. The range 
from the beginning to the current 
position is represented with  
and verbal-commented ranges are 
represented with . 

Index Mark 

Clicking  inserts an index mark at 
the Position control point. 

Displayed Area Slider 
Indicates the currently displayed 
range in the file with . Dragging 
the slider shifts the displayed range. 

 

 Tone Adjustment Control 
Clicking  and  or dragging the 
slider can adjust the tone in increments 
of 1% from 100% on the B side to 
100% on the T side. 

 Status Bar 
Displays the following information. 
First Area : The current operating state 
(Play, Stop, Fast-forward, Rewind, 
QUE, REVIEW) 
Second Area : Author ID 
Third Area : Worktype 
Fourth Area : Comment 

 Control Buttons 
Pressing these buttons moves the 
Playback Position control. 

 : Moves to the beginning of a 
file. 

 : Moves to the previous 
index mark or edge of a verbal 
comment. 

 : Rewinds a file.  Holding 
the button speeds up rewinding. 

 /  : Starts 
playback.  Pressing this button 
during playback stops it. 

 : Fast-forwards a file.  
Holding the button speeds up 
rewinding. 

 : Moves to the next index 
mark or start (or end) of a verbal 
comment. 

 : Moves to the end of a file. 
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Names and Functions of Playback Control Screen Components during 
Audio Capturing 

 
This Playback Control screen is displayed when clicking [Start Audio Capture] on the File menu. 
It can create a new audio file. Exiting the screen brings the user back to the Main screen. 
 
 

 
 

 Title Bar 
Displays the name of the file 
currently being played and the name 
of the folder in which the file is 
stored. 

 

 

 Playback 
Position/Recording Time Length 
Displayed on the immediate right of the 
Play bar in the format of HH:MM:SS. 
The playback position of a file is 
displayed in blue, and the total 
recording time length is displayed in 
white. 

  Timescale control 
Displays the timescale of the Play bar. 
The time frame can be changed in the 
range of one-minute width to the 
full-scale. Clicking  or  can change 
the timescale. 

  Volume Adjustment 
Control 
Allows for the adjustment of output 
sound volume. This function is not 
available with an older sound board 
that does not have electronic volume 
adjustment capability. In that case, 
adjust the volume manually. 

 

 Audio Output Display 
Displays the current state of audio 
playback. In the case of a monaural 
recording, the L and R outputs are 
displayed at the same height. 

 Control Panel 

 Priority Button 
This mark indicates the priority of a 
file. A red mark means that the file is 
assigned high priority. 

 Audio/Instruction 
Comment Mode Switching 
Button 
Switches between audio playback 
and Instruction Comment playback. 
In Instruction Comment mode, the 
icon turns to green and the Play bar is 
surrounded by a green line. 

 Information Button 
Clicking this button displays property 
information of a file. The Main screen 
does not have this button. 

 Switch Input Device 
Button 
Pressing this button displays the 
Select Input Device dialog box, 
enabling the user to select an input 
device. 

 User Setting Button 
Clicking this button displayes User 
Setting dialog box. Playback 
condition and Transcribe Bar setting 
can be changed. 

 Transcribe Bar Button 
Switches Playback Control Screen to 

 

 Playback Speed 
Adjustment Control 
Clicking  and  or dragging the 
slider can adjust the playback speed 
without changing the voice pitch 
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(sound pitch). 

 

 Noise Cancellation Control 
Clicking  and  or dragging the 
slider can adjust noise cancellation in 
four levels of 0, 1, 2, and 3. 

Transcribe Bar. 

 Show Status Bar Button 
Shows or hides the status bar.  The 
Main screen does not have this 
button. 

Pl
ay Bar and Position Slider 
Graphically displays which part of the 
current file is being played. The range 
from the beginning to the current 
position is represented with  
and verbal-commented ranges are 
represented with . 

Index Mark 

Clicking  inserts an index mark at 
the Position control point. 

Displayed Area Slider 
Indicates the currently displayed 
range in the file with . Dragging 
the slider shifts the displayed range. 

 

 Tone Adjustment Control 
Clicking  and  or dragging the 
slider can adjust the tone in increments 
of 1% from 100% on the B side to 
100% on the T side. 

 Status Bar 
Displays the following information. 
First Area : The current operating state 
(Play, Stop, Fast-forward, Rewind, 
QUE, REVIEW) 
Second Area : Author ID 
Third Area : Worktype 
Fourth Area : Comment 

 Control Buttons 
Pressing these buttons moves the 
Playback Position control. 

：Starts audio caputuring. 

 : Moves to the beginning of a 
file. 

 : Moves to the previous 
index mark or edge of a verbal 
comment. 

 : Rewinds a file.  Holding 
the button speeds up rewinding. 

 /  : Starts 
playback.  Pressing this button 
during playback stops it. 

 : Fast-forwards a file.  
Holding the button speeds up 
rewinding. 

 : Moves to the next index 
mark or start (or end) of a verbal 
comment. 

 : Moves to the end of a file. 
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Names and Functions of the Transcribe Bar Components 

 
This screen is specialized for playing certain files. 
When opening and transcribing a document file, you can work with the file more efficiently using the 
Transcribe bar without disrupting file editing. 
 

 
 

 Control Buttons 

 : Starts audio capturing. 

 : Moves to the previous 
index mark or edge of a verbal 
comment. 

 : Rewinds a file.  Holding 
the button speeds up rewinding. 

 /  : Starts 
playback.  Pressing this button 
during playback stops it. 

 : Fast-forwards a file.  
Holding the button speeds up 
rewinding. 

 : Moves to the next index 
mark or start (or end) of a verbal 
comment. 
 

  Counter 
Displays the current playback time 
length in the format of HH:MM:SS. 

 Audio/Instruction 
Comment Mode Switching 
Button 
Switches between audio playback 
and Instruction Comment playback. 
In Instruction Comment mode, the 
icon turns to green and the Play bar is 
surrounded by a green line. 

 Priority Button 
This mark indicates the priority of a 
file. A red mark means that the file is 
assigned high priority. 

 
 Volume Control Button 

With this button pressed, the slider is 
displayed, enabling the user to adjust 
the volume with mouse operations. 

 Speed Control Button 
Pressing this button displays the slider, 
enabling the user to adjust the 
playback speed with mouse operations. 

 Noise Cancellation Control 
Button 
Pressing this button displays the slider, 
enabling the user to adjust the noise 
cancellation level with mouse 
operations. 

 Tone Control Button 
Pressing this button displays the slider, 
enabling the user to adjust the tone 
with mouse operations. 

 Channel Separation Control 
Button 
Pressing this button cyclically switches 
the channel mode between Left, Right, 
Stereo, and Monaural. 

 Edit Index Mark Button 
Pressing this button inserts an index 
mark at the current unmarked position. 
Pressing this button at an 
index-marked position deletes the 
index mark. 

 Show/Hide Properties Button 
Pressing this button shows or hides the 
properties of the current file. 

 Extended Display Switching 
Button 
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Switches the display on the desktop 
and in the task bar. 

 
 Close Button 

Exits the Transcribe bar and brings the 
user back to the Main screen. 

 Displayed Area Slider 
Indicates the currently displayed 
range with  if the range is set to 
other than full scale with the Time 
Frame control. Dragging the slider 
shifts the displayed range. 

 Index Mark 
Indicates an index-marked position. 

 
  Option Button Switching 
Shows or hides the option buttons. 
 

 Change Microphone Device Button 
Pressing this button displays the Select 
Input Device dialog box, enabling the 
user to select an input device. 
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Names and Functions of the Transcribe Bar Components at Audio 
Capturing 

 

This Transcribe bar is displayed when clicking  or [Start Audio Capture] on the File menu. 
It can create a new audio file. Exiting the screen brings the user back to the Main screen. 

 
 

 Control Buttons 

 : Starts audio capturing. 

 : Moves to the previous 
index mark or edge of a verbal 
comment. 

 : Rewinds a file.  Holding 
the button speeds up rewinding. 

 /  : Starts 
playback. Pressing this button during 
playback stops it. 

 : Fast-forwards a file. 
Holding the button speeds up 
rewinding. 

 : Moves to the next index 
mark or start (or end) of a verbal 
comment. 

 Option Buttons 

 Volume Control Button 
Functions as volume during play/stop; 
functions as microphone input during 
recording. 

 Select Input Device Button 
Pressing this button displays the Select 
Input Device dialog box, enabling the 
user to select an input device. 

 Edit Index Mark Button 
Pressing this button inserts an index 
mark at the current unmarked position. 
Pressing this button at an 
index-marked position deletes the 
index mark. 

 Show/Hide Properties Button 
Pressing this button shows or hides the 
properties of the current file. 

 
 Close Button 

Exits the Transcribe bar and brings the 
user back to the Main screen. 

  Counter 
Displays the current playback time 
length in the format of HH:MM:SS. 

Audio/Instruction Comment 
Mode Switching Button 
Switches between audio playback 
and Instruction Comment playback. 
In Instruction Comment mode, the 
icon turns to green and the Play bar is 
surrounded by a green line. 
します。 

Priority Button 
This mark indicates the priority of a 
file. A red mark means that the file is 
assigned high priority. 

 
  Option Button Switching 
Shows or hides the option buttons. 
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 Displayed Area Slider 
Indicates the currently displayed 
range with  if the range is set to 
other than full scale with the Time 
Frame control. Dragging the slider 
shifts the displayed range. 

Index Mark 
Indicates an index-marked position. 

  

 

Audio Tree View (Main Screen) 

 
The Audio Tree view is displayed on the left part of the Main screen. 

 
 

 Tool Bar 
Displays the tool buttons for working 
with a file. 
For information on the functions, refer 
to the Folder menu section in Menu List. 

 Title 
Displays the name of the view. 

 Pin Button 
Switches the display mode of the 
view between automatically hidden 
and always displayed. 

 (On): Always displayed. 

 (Off): Automatically hidden 
when not in use. To display the view 

again, press in the Content List 
view. 

 
The folder structure under the Dictation 
tray is displayed. 
For information on each folder, refer to 
How Folders Work. 
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Device Tree View (Main Screen) 

 
The Device Tree view is displayed on the left part of the Main screen. 
This view is displayed when the device is connected. It displays with icons the devices supported by 
Dictation Module. 

 
  

 Tool Bar 
Displays the tool buttons for working 
with a file. 
For information on the functions, refer 
to the Device menu section in Menu 
List. 

 [Hide/Restore] button 

 Pressing  hides the Device Tree 
view. 

 Pressing  shows the Device 
Tree view again. Note that if no 
device is connected, pressing this 
button does not show the view.  

The folder structure under Device 
Manager is displayed. 
For information on each folder, refer to 
How Folders Work. 
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Content List View (Main Screen) 

 
The Content List view is displayed in the center of the Main screen.  It cannot be hidden. 

 
 

   : Shows or hides the Audio 
List view. 

Title 
Displays the name of the list view 
(either the Dictation List or Document 
List) displayed in the view area. 

 : Switches the Filter of the list 
view on or off. 

 : Switches the in-line editing 
function of the list view on or off. 

  Shows or hides the 
Properties view. 

 View Area 
Displays audio or document files in the 
folder selected in the Folder Navigation 
Pane. 
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Information View (Main Screen) 

 
The Information view is displayed on the bottom center of the Main screen. This view is hidden by default. 

 
 

 [Hide/Restore] button 

 Pressing  hides the Device Tree 
view. 

 Pressing  shows the Device 
Tree view again. Note that if no 
device is connected, pressing this 
button does not show the view. 

 Title 
Displays either "Document List", 
"Document Preview", or "Mail 
Preview". 

 : Switches the displayed 
view. 

 Pin Button 
Switches the display mode of the 
view between automatically hidden 
and always displayed. 

 (On): Always displayed. 

 (Off): Automatically hidden 
when not in use. To show the view 

again, press . 

 View Area 

Document List 
Lists all the document files under the 
Document tray when the contents of 
the Dictation folder are displayed in the 
Content List view. Dragging one of the 
document files to an audio file in the 
Content List view can link the document 
file with the audio file. 

Document Preview 
Displays the content of a selected 
document file when the contents of the 
Document folder are displayed in the 
Content List view. It also displays the 
content of a linked document file when 
the contents of the Dictation folder are 
displayed in the Content List view. 

Mail Preview 
Displays the content of email.  When 
sending an audio file selected in the 
Content List view via email, its content 
is displayed. 
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Properties View (Main Screen) 

 
The Properties view is displayed on the right part of the Main screen.  This view is hidden by default. 

 
 

 Title 
Displays the name of the view - either 
"Property" or "Job History". 

   : Switches the displayed 
view. 

 Pin Button 
Switches the display mode of the 
view between automatically hidden 
and always displayed. 

 (On): Always displayed. 

 (Off): Automatically hidden 
when not in use. To display the view 

again, press  in the Content List 
view. 

(Customize) Button 
Shows or hides an item or category in 
the Properties view. 
 

 Property View 
Displays the properties of the selected 
file or folder. The items displayed in 
black characters can be edited. 

 : Displays the properties by 
category. 

 : Displays all properties in 
alphabetical order. 

 : Displays the history of the 
dictation file. 

Job History View 
Displayed only when Dictation is 
selected in the Content List view. It 
displays the history from the creation of 
the selected audio file to the completion 
of its transcription (or to the completion 
of transmission if the audio file has 
been sent via email or FTP). 
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8.2 Menu Lists 
 
This section describes the menus provided by the Transcription Module. 
 

8.2.1 [File] Menu 

 
Command Name Butt

on 
Functions 

Start Transcription 

 

Starts transcription. A specified word 
processor is started when starting 
transcription. 

Start Audio Capture 

 

Displays the setting screen and starts 
audio capturing. 

Convert Dictation 

 

Converts a selected audio file into a 
specified file format. 

Start Voice Recognition 

 

Voice-recognizes a selected audio file 
using Dragon NaturallySpeaking. 

Import Dictation 

 

Imports an unmanaged external audio 
file. 

Export Dictation 
 

Converts a selected audio file into 
external media. 

Split 

 

Splits a selected file at a specified 
position into two files. 

Join 

 

Joins multiple selected files into a single 
file. 

Encrypt 

 

Encrypts a selected file. 

Decrypt 

 

Decrypts a selected encrypted file. 

Open Document 

 

Opens a selected document file. When 
running this operation with an audio file 
specified, the linked document file is 
opened. 

Associate with 
Document  

Associates a selected audio file with a 
specified external document file. The 
associated document is copied to My 
Document and managed with the 
linkage. 

Remove Association 
with Document  

Dissociates an audio file from its linked 
document file. 

Edit Job Data 
 

Edits the job data of a selected audio 
file.  Job data refers to several editable 
settings - Author ID, Worktype ID, 
Option Items, and Comments. 

Change Status 

 

Changes the status of a selected audio 
file. 

Exit - Exits Transcription Module. 
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8.2.2 [Folder] Menu 

 
Command Name Butt

on 
Functions 

New Folder 
 

When the Transcription tray is focused on, a 
custom folder is created at the same tier as 
the Download tray. 
When a folder in the Download tray is focused 
on, a subfolder is created under the folder. 

Add Folder 
 

Opens the Select Folder dialog box, with 
which, at the same tier as the Download tray, 
you can create a shortcut folder path to a 
specified external folder. 

Remove Folder 
 

Deletes the shortcut folder (shortcut path to 
an external folder) created with [Add Folder]. 

Rename Folder 
 

Renames a selected folder. 
The folders in the Download tray and custom 
folders are shortcut folders only maintained 
internally by DSS Player. When renaming is 
applied to these folders, only the shortcuts 
are renamed and their actual folders are not.  
Subfolders are real folders and can be 
renamed. 

Folder Setting 
 

Starts the Folder Setting dialog box, with 
which you can configure the attributes of a 
folder. 

 

8.2.3 [Edit] Menu 

 
Command Name Butt

on 
Functions 

Cut 

 

Copies a selected audio file to the clipboard.  
Pasting the audio file after cutting it moves the 
file to a specified folder. 

Copy 

 

Copies a selected audio file to the clipboard.  

Paste 

 

Moves or copies the audio file copied to the 
clipboard with the Cut or Copy command into a 
specified folder. 

Delete 

 

Deletes a selected audio or document file. 

Select All - Selects all the files in the Content List view. 
Copy to Folder 

 

Copies the audio file selected in the Content 
List view to a specified folder. 

Move to Folder 

 

Moves the audio file selected in the Content List 
view to a specified folder. 
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8.2.4 [View] Menu 

 
Command Name Butt

on 
Functions 

Switch to Playback 
Control Window  

Switches from the Main screen to the 
Playback Control screen or Transcribe bar. 
The audio file selected in the Main screen 
begins playing. 

Folder Navigation - Shows or hides the Audio Tree view or 
Device Tree view. 

Property Window - Shows or hides the Properties view. 
Information Window - Shows or hides the Information view. 
Tool Bar - Show or hides the Standard Edit E-mail/FTP 

Customize tool bar. 
Status Bar - Shows or hides the status bar.  
Playback Control Bar - Shows or hides the Playback Control bar.  
Gridlines - Shows or hides the grid lines in the Content 

List view and Information view. 
Columns to Display - Shows or hides the columns in the audio list 

and configures their display order. 
Sort by - Sorts, in alphabetical order, the files by the 

displayed columns selected in the Content 
List view and Information view. 

Filter On/Off 
 

 

Enables or disables the filtering function. 

In-line editing 
 

 

Enables or disables direct editing of the 
items displayed in the audio list. Clicking a 
configurable item in the list makes the field 
editable. 

Refresh 

 

Refreshes the audio list in the Main screen.  
The audio list refers to cached data to 
speed up the display. Since refreshing the 
list causes the cached data to be rebuilt, it 
may take a while to display a large list. 
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8.2.5 [Play] Menu 

  
Command Name Button Functions 

Play/Stop 
 

 

Plays a selected file or the first file on the 
list, in the Content List view, from the 
Position control point on the Play bar. 
Clicking this menu during playback stops 
it. 

Fast Forward 
 

Fast-forwards a file. Holding the button 
speeds up rewinding. 

Rewind 
 

Rewinds a file. Holding the button speeds 
up rewinding. 

Next Index Mark  
 

Moves the Position control to the next 
index mark or start (or end) of a verbal 
comment. 

Previous Index 
Mark  

Moves the Position control to the 
previous index mark or start (or end) of a 
verbal comment. 

Volume  Adjusts output sound volume. 
Speed 

 

Speeds playback up or down. 

Tone 

 

Configures the tone, placing an emphasis 
on the high or low pitch area. 

Noise Cancellation 

 

Selects the level of noise cancellation 
from 0, 1, 2, and 3. A larger number 
means a higher amount of noise 
cancellation. 

Channel - Selects a channel for sound to be played. 
Stereo: Plays as stereophonic sound. 
Monaural: Plays as monophonic sound. 
Left channel only: Plays only the left side 
track of stereophonic sound. 
Right channel only: Plays only the right 
side track of stereophonic sound. 

Insert Index Mark 
 

Inserts an index mark at the 
Position control point. 

Delete Index Mark 

 

Deletes an index mark at the Position 
control point. 

View All Index 
Marks  

Displays the View All Index Marks dialog 
box. 

Next Verbal 
Comment  

Moves the Position control to the next 
index mark or start (or end) of a verbal 
comment. 

Previous Verbal 
Comment  

Moves the Position control to the 
previous index mark or start (or end) of a 
verbal comment. 

Dictation / 
Instruction 
Comment Mode 

- Switches between Audio File mode and 
Instruction Comment mode if an 
Instruction Comment has been recorded 
in the currently selected audio file. 

Intro Scan 

 

Sequentially plays only the first five 
seconds of the files selected or displayed 
in the Content List view. 
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8.2.6 [Tool] Menu 

Command Name Butt
on 

Functions 

Select Speaker 

 

 

Selects speakers, either the ones supplied 
with the PC or the ones provided by a 
connected digital voice recorder, when playing 
a file. 

Submit for E-mail 

 

Manually moves a selected audio file to the 
email sending box. If multiple email profiles 
have been registered, select a profile for 
transmission with the pop-up menu. 

Submit for FTP 

 

Manually sends a selected audio file via FTP. 

Send and Receive 

 

The Send command sends an email in the 
sending box or a file via FTP to the server. 
When transmission successfully completes, 
the audio file is moved to Sent Items. The 
Receive command initiates the reception of 
document files. 

Hotkeys On/Off 

 

 

Enables or disables Hot keys. 

Keyboard Settings - Displays the user-configured keyboard 
options. It enables the user to assign Hot keys 
to Transcription Module commands, and to 
delete or modify the assignments. 

OLE Settings - From the following two ways, selects how to 
handle audio data when dropping a DSS or 
DSS Pro file selected in the Content List view 
into an OLE-enabled application: 
･ Embedding the audio file in a document file 
･ Embedding only the link information in a 
document file 

Options 

 

The Option Settings dialog box appears. 
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8.2.7 [Device] Menu 

 
Command Name Butt

on 
Functions 

Download Folders 
A-G 

- Downloads all files in Folders A-G in the 
device displayed in the Device Tree view 
(recorder, PCMCIA card, or removable 
drive) into the corresponding Folders A-G in 
the Download tray in the Audio Tree view. 

Download Selected 
Files 

- Downloads only selected files into the 
Download tray in the Audio Tree view. 

Download All 

 

Downloads all files in the device displayed in 
the Device Tree view into the corresponding 
Folders A-G in the Download tray. Files in 
the removable drive that have no folder are 
downloaded into Folder A. 

Upload Selected Files 

 

Uploads the files selected in the Audio Tree 
view into the device displayed in the Device 
Tree view. 

Change Device Mode 
 

Switches the device mode of a connected 
device to Audio mode or Storage mode. 

Change Storage 
Media  

This command is enabled only for DS-5000.  
DS-5000 provides two types of media: the 
SD card and micro SD card. This command 
specifies the contents of which media is 
displayed when the device is connected via 
USB to the PC. It is impossible to display the 
contents of both media simultaneously. 

Synchronize 
Date/Time  

Synchronizes the date and time of the 
recorder with those of the PC. The device 
can also be automatically synchronized with 
the PC when connected. 

Foot Switch Setting 

 

With this menu, the functions of a connected 
foot switch can be configured via the PC. 

  

8.2.8 [Help] Menu 

 
Command Name Butt

on 
Functions 

Contents F1 Displays Help for Transcription Module. 
Check for Updates - Checks the Olympus download server for 

the latest Updates and downloads them if 
present. 

About Transcription 
Module 

- Displays the version information of 
Transcription Module. 
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8.3 File Property Lists 
 
This section provides the property lists of audio and document files displayed in the Content List view. 

 
The R/W column describes the Read and Write attributes. 
The Filter column indicates whether or not the filter is set. The Option column shows the option setting for 
filtering. 

 

Displayed Property List (Audio File List view) 

 
The Filter column indicates whether or not the filter is set. The Option column shows the option setting for 
filtering. 
 

Property Description R/W*1 Filter Option 

Priority Level A numeric value representing the priority 
level, ranging from 0 to 15 

R/W Yes Value 

Priority Priority 
(High/Normal)  

R/W Yes No 

Voice Recognition Whether or not the audio file has been 
voice-recognized 

R Yes No 

Instruction 
Comment 

Whether or not the audio file is 
instruction-commented 

R Yes No 

Encrypted Whether or not the audio file is encrypted R Yes No 

Locked Whether or not the audio file is locked R Yes No 

File Name The name of the audio file R/W No --- 
Job Number A numeric value representing the job 

number 
R No --- 

Author The Author name R/W Yes No 
Worktype The Worktype name R/W Yes No 
Created The date and time of when the audio file 

started 
R Yes Date 

Completed The date and time of when the audio file 
was finished 

R Yes Date 

Downloaded The date and time of when the audio file 
was downloaded 

R Yes Date 

Deleted Date The date and time of when the audio file 
was deleted. 

R Yes Date 

Backup Date The date and time of when the audio file 
was backed up 

R Yes Date 

Transcriptionist The name of the Transcriptionist R Yes Date 
Transcription 
Started 

The date and time of when a transcription 
started 

R Yes Date 

Transcription 
Completed 

The date and time of when a transcription 
ended 

R Yes Date 

Process/Status The Process/Status of the audio file 

：ProcessRecording 

：ProcessTranscription 

：ProcessVoiceRecognition 

：ProcessExport 

：ProcessArchive 

R/W Yes No 

Length The recording time length of the audio file 
(HH:MM:SS) 

R Yes Value 
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File Size The size of the audio file (KB) R No --- 
Option Item 1 The content of Option Item 1 R/W Yes No 
Option Item 2 The content of Option Item 2 R/W Yes No 
Option Item 3 The content of Option Item 3 R/W Yes No 
Option Item 4 The content of Option Item 4 R/W Yes No 
Option Item 5 The content of Option Item 5 R/W Yes No 
Option Item 6 The content of Option Item 6 R/W Yes No 
Option Item 7 The content of Option Item 7 R/W Yes No 
Option Item 8 The content of Option Item 8 R/W Yes No 
Option Item 9 The content of Option Item 9 R/W Yes No 
Option Item 10 The content of Option Item 10 R/W Yes No 
Comment Comments for an audio file R/W Yes No 
Document The name of a document file linked with an 

audio file 
R No --- 

File Format The extension of the audio file R Yes No 
Audio Format The format of the audio file R Yes No 
Original Location The folder in which the audio file was 

originally stored 
R Yes No 

Sender The sender of the audio file R Yes No 

Received Date 
The date and time of when the audio file 
was received 

R Yes Date 

Receiver The receiver of the audio file R Yes No 

Forwarded Date 
The date and time of when the audio file 
was forwarded 

R Yes Date 

Sent Date The date and time of when the audio file 
was sent 

R Yes Date 

Location The location of where the audio file is stored 
(full path) 

R No --- 

DSS License The name of the vendor that supplies the 
codec for the audio file 

R Yes No 

*1: The R/W column describes the Read and Write attributes. 
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Displayed Property List (Document List view) 

The following table lists the properties displayed in the Document List view and their descriptions. 
R/W: Read and Write attributes. The items that have the W attribute are user-editable. 
Filter : Whether or not the filter is set. 
Option : Option setting for filtering 
 

Property Description R/W Filter Option 

Priority Level A numeric value representing the priority 
level, ranging from 0 to 15 

R/W Yes Value 

Priority Priority 
(High/Normal)  

R/W Yes No 

Voice Recognition Whether or not the audio file has been 
voice-recognized 

R Yes No 

Instruction 
Comment 

Whether or not the audio file is 
instruction-commented 

R Yes No 

Encrypted Whether or not the document file is 
encrypted 

R Yes No 

Locked Whether or not the document file is locked R Yes No 

File Name The name of the document file R/W No - 
Author The Author name R/W Yes No 
Worktype The Worktype name R/W Yes No 
Transcriptionist The name of the Transcriptionist R Yes Date 
Transcription 
Started 

The date and time of when a transcription 
started 

R Yes Date 

Transcription 
Completed 

The date and time of when a transcription 
ended 

R Yes Date 

Process/Status The Process/Status of the audio file 

：ProcessRecording 

：ProcessTranscription 

：ProcessVoiceRecognition 

：ProcessExport 

：ProcessArchive 

R/W Yes No 

Option Item 1 The content of Option Item 1 R/W Yes No 
Option Item 2 The content of Option Item 2 R/W Yes No 
Option Item 3 The content of Option Item 3 R/W Yes No 
Option Item 4 The content of Option Item 4 R/W Yes No 
Option Item 5 The content of Option Item 5 R/W Yes No 
Option Item 6 The content of Option Item 6 R/W Yes No 
Option Item 7 The content of Option Item 7 R/W Yes No 
Option Item 8 The content of Option Item 8 R/W Yes No 
Option Item 9 The content of Option Item 9 R/W Yes No 
Option Item 10 The content of Option Item 10 R/W Yes No 
Dictation The file name of the dictation linked with a 

document file 
R No --- 

File Format The extension of the audio file R Yes No 
File Size The size of the audio file (KB) R No --- 
Receiver The receiver of the document file R Yes No 
Sent Date The date and time of when the document 

file was sent 
R Yes Date 

Location The location of where the audio file is stored 
(full path) 

R No --- 

 
 



144 / 168 
 

8.4 Default Key Assignments 
 
This section provides the lists for default key assignments. 
 

Default Key Assignments 

 
Playback Control Key Assignments 
General Key Assignments 
Function Assignments for Function Keys 

 

Playback Control Key Assignments 

Command Default Key 

Play/Stop F9 
Stop - 
Fast Forward F8 
Rewind F7 
Next Index Mark Ctrl+Right 
Previous Index Mark Ctrl+Left 
Next Verbal Comment Ctrl+Shift+Right 
Previous Verbal Comment Ctrl+Shift+Left 
Jump to Top - 
Jump to End - 
Volume Up Ctrl+Up 
Volume Down Ctrl+Down 
Speed Up Ctrl+Shift+Up 
Speed Down Ctrl+Shift+Down 
Tone Up Ctrl+Alt+Up 
Tone Down Ctrl+Alt+Down 
Noise cancellation level*1 - 
Insert Index Mark - 
Delete Index Mark - 
Dictation/Instruction Comment Mode F10 
Switch Playback View Mode - 
Switch Remain / Length Indication - 
Back to the Main Window Ctrl+Shift+Z 
*1 : Each command execution cyclically switches the level in the order of Off, 1, 2, 3, Off, and so 

on. 

  

General Key Assignments 

 

Command Default Key 

Start Transcription Ctrl+O 

Start Voice Recognition Ctrl+R 
Property View  

Hotkeys On/Off F12 
Download All Ctrl+Shift+M 

Command Default Key 
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Function Assignments for Function Keys 

 
Function Key Windows Standard DSS Player Pro 

[F1] Display Help Display Help 
[F2] Edit Item Edit Item 

[F3] Search --- 
[F4]   

[Ctrl]+[F4] Close Window Exit Application 
[Alt]+[F4] Exit Application Exit Application 

[F5] Refresh Window Refresh Window 

[F6]  Move Pane 
[F7]  Rewind 
[F8]  Fast Forward 
[F9]  Play/Stop 

[F10]  
Switch Dictation/Instruction 

Comment Mode 
[Shift]+[F10] Show Context Menu Show Context Menu 

[F11]   
[F12]  Hotkey On/Off 
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8.5 Names and Functions of Option Settings Dialog Boxes 
Components 
 
This section describes the names and functions of the components comprising the Option Settings dialog 
boxes, which are used for configuring various options. 
 

Folder Design Dialog Box 

 
This dialog box is used to configure folder-related settings. 

 
 

 Category Bar 
Selects the category of the profile. 
The currently selected category is 
highlighted. 
The setting information included in 
the profile falls into the following 
categories. 

 Folder Tree 
Configures the folders in the Dictation 
tray and Document tray.  
Turning the checkbox on or off 
enables or disables the 
corresponding folder. 

 Create Folder Buttons 
[New]: Creates a new folder.  A 
created folder is displayed between the 
Download tray and Recording folder. 
[Add]: Adds a specified external folder 
path as a custom folder to the Audio 
Tree view. 
[Remove]: Removes a shortcut folder 
previously created with [Add]. 
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 Folder Properties 
Displays the properties of the folder 
selected from the folder tree. 
The properties are configured for 
each folder. 
Configurable properties vary 
depending on the folder type. 

Sorts the properties by 
category. 

Lists the properties in 
alphabetical order. 

 
[OK]: Fixes settings. 
[Cancel]: Exits without modifying 
settings. 
[Apply]: Enables changes. 

 

Browse for folder Dialog Box 

 

 
 
Select a folder and click [OK]. 
 

Change Password Dialog Box 

 

 
 
Enter a password in the New Password and Confirm Password fields and click [OK]. 
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Support Document Type Dialog Box 

 

 
 

• To register an extension, type it in the [Supported document extension] box and click [Add]. 

• To delete an extension, select it from the [Supported document] list and click [Remove]. 

• When configuration has been completed, click [OK]. 
 

Convert Settings Dialog Box 

 

 
 
Specify the settings and click [OK]. 
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Auto Send via E-mail Setting Dialog Box 

 

 
 

• Click To, CC, and/or BCC to specify the addresses. 

• Type in a title and body in the Subject and Note boxes respectively. 
 
Specify the settings and click [OK]. 
 

Auto Send via FTP Setting Dialog Box 

 

 
 
Specify the settings and click [OK]. 
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Cleaning Settings Dialog Box 

 

 
 

• Enable the Cleaning setting, specify the retention period, and click [OK]. 
 

Purge Setting Dialog Box 

 

 
 
Specify the settings and click [OK]. 
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File Name Setting Dialog Box 

 

 
 

• By selecting the checkbox of an item, its setting is applied to the file name. Note that File Name is a 
required item. 

• To change the order of items, select an item and use the Up and Down buttons to change its position. 

• Setting a separator inserts it between selected items. 
The separator is selected from the drop-down list. 
[none] 
  [space] 
 - [hyphen] 
 . [period] 
 _ [underscore] (Default) 

• [Preview] displays the format of a file name resulting from renaming being configured. 
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Edit Job Data Dialog Box 

 

 
• This dialog box is used to configure job data (Author ID and Priority Level) for a file. 

• Select the Author ID and Worktype ID from the drop-down lists. 

• Enter the label names and values of option items. 
 
Specify the settings and click [OK]. 
 

Rule Setting Dialog Box 

 

 
 
Configure the Author ID and destination folder of an audio file, and then click [OK]. 
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Notification Window 

 

Notification Window (Default) 

 

 
 

• Clicking [Detail>>] displays the Notification window (Detailed display). 

Notification Window (Detailed Display) 

 

 
 

• Clicking [<<Detail] returns the display to default. 

• Clicking  closes the dialog box. 
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Configure Notification Dialog Box 

 

  
 

• " Select Items" 
Enables or disables the items displayed on the pop-up window. 
Priority level (Always enabled) 
File name (Always enabled) 
Author ID (Default: Enabled) 
Worktype ID (Default: Disabled) 
Folder (Default: Enabled) 
Received (Default: Enabled) 
Sender (Default: Disabled) 
Option items 1-10 (Default: Disabled) 
Automatic closing 

• To change their display order, select an item and use the Up and Down buttons to change its position. 

• To return the settings to default, click [Reset]. 

• "Automatic Closing" 
With "Close the Notification window automatically" enabled, the Notification window is 
automatically closed after the length of time configured with [Displayed only for]. 
Configure the display length of time in the range from 3 to 30 seconds with [Displayed only for]. 
(Default: 10 seconds) 
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Routing Dialog Box 

 

 
 
Specify the settings and click [OK]. 
 

Author Property Dialog Box 

 
The Author ID and Priority Level can be configured. 

 
 
Specify the settings and click [OK]. 
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Worktype Property Dialog Box 

 
This dialog box is used to configure the Worktype ID, Option Items, and the barcode input option. 

 
 

Option Item 

The Worktype ID and Option Items are configured. 
Worktype ID can be entered using up to 16 desired characters. 
Up to 10 Option Items can be registered. 

• To add an Option Item, configure it in the Option Item Property dialog box, which is displayed by clicking 
[Add]. To enable an Option Item when making a recording on the recorder side, select the checkbox of its Label. 

• To modify an Option Item, select its Label and click [Modify]. Then, make changes to the Option Item in the 
Option Item Property dialog box. 

• To delete an Option Item, select its Label and click [Remove]. 

• To change the order of Option Items, select a Label and use the Up and Down buttons to change the item's 
position. 

 

 
Limitations on Option Items 
When creating an audio file, up to 10 Option Items are registered using 
the DS2 recording format, while only three of them are recorded using 
the DSS recording format. 

 

Barcode Input Option 

This option configures the input method when using barcodes to input values to the Option Items 
registered in the Option Item list. 

• With [Barcode input option] set to "Bulk scanning" in the Worktype Property dialog box, one barcode 
scanning populates multiple Option Items with data. The start and end digit numbers for scanning can be set in 
the Option Item Property dialog box. 

• With [Barcode input option] set to "Separate scanning", one barcode scanning populates a single Option 
Item with data. If multiple Option Items have been registered, separate barcode scannings sequentially 
populate the Option Items with scanned data. 
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Description 

The description of the Worktype is registered. Up to 100 characters can be entered. 
 

Option Item Property Dialog Box 

 
This dialog box is used to configure an Option Item. 
 

• For the Label, any string can be entered using up to 16 characters. 

• For the Default Value, any value can be specified using up to 20 characters. 

• For the Initially Displayed Value, the default value of the label when making a recording with a recorder is 
selected. 
(Blank/Default/Last Entered Value) 

• For the Start and End Digit Numbers for Barcode Scanning, the range of string extracted from scanned 
data is specified with the start and end digit numbers. 

 

 
Limitations on the Label 
When using the DSS recording format, only up to eight characters in a 
registered Label name string can actually be used. Subsequent 
characters are not recorded in a file. 

 

Recording Format Setting Dialog Box 

 

 
• Select the recording format from the Format drop-down list. 

• Select the bit rate and stereo/monaural settings for a specified recording format from the Attribute 
drop-down list. 
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Template Association Dialog Box 

 

 
Specify the settings and click [OK]. 
 

E-mail Settings (Select) Dialog Box 

 

 
• Select an email sending/receiving protocol for registration and click [Next]. 

The E-mail Settings dialog box for the selected protocol appears. 
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E-mail Settings (POP/SMTP) Dialog Box 

 

 
 

• To configure advanced settings, use the Advanced Settings (POP/SMTP) dialog box, which is displayed by 
clicking [More settings]. 

• Pressing [Test settings] initiates a test to determine whether or not a file can successfully be uploaded and 
downloaded with the current settings in the dialog box, and then displays the result. 

• Specify the settings and click [Finish]. 
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Advanced Settings (POP/SMTP) Dialog Box 

 

 
 
Specify the settings and click [OK]. 
 

E-mail Settings (IMAP) Dialog Box 
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• Pressing [Test settings] initiates a test to determine whether or not an email can successfully be sent and 
received with the current settings in the dialog box, and then displays the result. 

• To configure advanced settings, use the Advanced Settings (IMAP) dialog box, which is displayed by 
clicking [More settings]. 

• Specify the settings and click [Finish]. 
 

Advanced Settings (IMAP) Dialog Box 

 

 
 
Specify the settings and click [OK]. 
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E-mail Settings (GroupWise) Dialog Box 

 

 
 
Specify the settings and click [Finish]. 
 

E-mail Settings (Lotus Notes) Dialog Box 

 

 
 
Specify the settings and click [Finish]. 
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E-mail Settings (Extend MAPI) Dialog Box 

 

 
 
Specify the settings and click [Finish]. 
 
 

FTP Settings Dialog Box 

 

 
 

• Pressing [Test settings…] initiates a test to determine whether or not a file can successfully be uploaded 
and downloaded with the current settings in the dialog box, and then displays the result. 

• Specify the settings and click [Finish]. 
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8.6 Glossary 

Backup 
With a folder configured for backup, the audio files dropped into the folder can be 
automatically backed up to a specified folder. 

Citrix Presentation Server 
A client/server system that allows a shared server application to be started from multiple 
client OSes including Windows, Macintosh, and Linux. 

Clean 
A folder attribute and a way to delete files. Old files can be deleted through one of two 
methods: directly deleting them or moving them to the Recycle Box and then deleting them 
with the delete option of the box.  Setting the Clean attribute enables automatic cleanup of 
old files. 

Composite Mode 
This mode supports multiple device classes. Recorders support the Audio and HID classes 
(note that DS-5000 supports the Audio, HID, and Storage classes). 

Direct Record 
A recording method that records audio data directly onto the hard disk drive of a PC with a 
connected DirectRecording device. DR-1000 and DR-2000 are the devices specialized for 
direct recording. Some DVR models also support direct recording. 

DRM 
This stands for Digital Rights Management. It is a general term for the technologies that 
protect the copyrights of digitally-created contents and regulate the use and replication of 
them.  

DSS 
This stands for Digital Speech Standard. 

This voice encoding standard has been developed by Olympus and two other companies. It 
can downsize audio data while maintaining sound quality. All of Olympus recorder models 
support DSS. DSS-compliant audio files have the "DSS" extension. 

DSS Pro 
An audio standard enhanced from the classic DSS. 

Key differences from the DSS standard include QP (Quality Play) mode for high-grade 
recording, an increase from 16 to 32 in the number of settable index marks, and support for 
audio file encryption. DSS Pro-compliant audio files have the "DS2" extension. 

FTP 
This stands for File Transfer Protocol. This is a protocol used for transferring a file over the 
TCP/IP network. 

Hot Key 
A function that allows operation of an application or a button on the device to be assigned to 
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a key on the keyboard and executed simply by pressing the key. It can be customized and 
enables the user to work more efficiently by registering frequently used functions. 

HTTPS 
A protocol that integrates SSL (Secure Sockets Layer) encrypted communication into HTTP. 

Instruction Comment 
An Instruction Comment is instructions or other messages recorded for a Transcriptionist. An 
instruction comment can be created only with Direct Record and cannot be prepared when 
making a recording with a standalone recorder. It is maintained as a file separately from an 
audio file and is recorded to provide a Transcriptionist with instructions. 

Job Data 
A collective term for several basic settings - Author ID, Worktype, Option Items, and 
Comment. 

By centrally managing this setting data as Job Data on the application side, each dictation 
can be edited and configured more easily. 

Noise Cancellation 
An operation that reduces noise output by extracting and filtering out noise components from 
an audio file.  The cancellation effect can be adjusted in three levels. 

MP3 
An MPEG-1-based audio compression method. Like other major audio compression 
techniques, it uses a lossy compression method that achieves a high compression rate by 
deducting less audible portions from sound data. DSS Player supports it only for playback. 
The file extension is .MP3. 

MSI Package 
A Windows Installer-compliant package for installation. DSS Player Pro R5 utilizes the MSI 
packages of modules when performing installations and upgrades. 

OLE 
When dragging and dropping an audio file to a document file, it can be configured to be either 
an embedded object or linked object. 

An embedded object brings all audio data into the file, resulting in a larger amount of data, 
which can be played on another PC that has DSS Player installed. A file only linked with audio 
data retains the file name and path of an audio file, resulting in a smaller amount of data, 
which may not be able to be played if it cannot refer to the path of the audio data. 

Option Item 
Items associated with a work type. Up to 10 items can be registered with a combination of 
numbers. 

Option Items can be input with tools such as Baltech Transponder or a barcode reader. 

Ownership 
An attribute that, based on an Author's privilege, prevents an audio file from moving to the 
Finished folder in Transcription Module after transcription. With this attribute configured, the 
file is not moved to the Finished folder in the Transcription Module when transcription has 
been completed. 
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Under review, with the Ownership attribute configured, the dictations in the folder can only 
be manipulated (moved and deleted) by the Author. 

Priority 
This is represented by the 16 priority levels, from 0 to 15, and allows the user to prioritize 
dictations. 

Proxy 
This is a boundary that separates an internal network from the external Internet. It is a 
computer or software that connects to the Internet on behalf of an internal computer that 
cannot directly access the external network. A proxy centrally controls the access traffic 
between the Internet and the internal network, and blocks unauthorized access. 

Repository 
A hierarchically structured database that stores shared data managed by System 
Configuration Program.  It stores the profiles of users, profiles of groups, and Update 
information. 

Stand-alone System 
The basic system of DSS Player Pro R5. It represents a system environment in which 
Dictation Module and Transcription Module run on local PCs and management tools such as 
System Configuration Program are not used. 

Storage Mode 
In this mode, the device is recognized as large storage media when connected to a PC. 

The memory or memory card installed in the recorder is recognized as a removable drive, 
and the files stored there can be accessed just as those on a hard disk. 

Terminal Service 
This is a client service provided by Windows Server. It can execute applications and services 
provided by the server on the client side. A separate license such as TS-CAL is required to use 
this function. 

VCVA 
A capability that enables sound-initiated recording (called Variable Control Voice Actuator) in 
order to improve usability and efficiency for prolonged recording. It halts recording after a 
certain period of silence and resumes it in response to sound. The sound level to initiate 
recording can be adjusted. A level setting optimized for a recording environment ensures an 
efficient recording. For recording intended for voice recognition, disabling the VCVA function 
is recommended. 

Verbal Comment 
A voice comment that is embedded in audio file data. A verbal comment can be recorded with 
a supported recorder. It is provided to transcribe audio data immediately after commentary. 
A verbal comment is recorded at any position in an audio file based on the need for 
instructions. 

WAV 
A standard audio file format for Windows. It is also referred to as the WAVE format. The 
specifications include the saving format for recording a digitally converted audio signal. The 
file extension is .WAV. 



167 / 168 
 

WMA 
A standard audio format for Windows. This technology is a component of Windows Media, a 
multimedia technology incorporated in Windows, and is a standard audio compression 
technique. The file extension is .WMA. 

Workgroup System 
The middle-class system of DSS Player Pro R5. It represents a multi-user system 
environment in which multiple licenses are managed by License Manager and user settings 
can be maintained with System Configuration Program. 

Worktype 
This is data used to classify dictations. The user can classify the types and Authors of 
dictations with the application by selecting a Worktype on the recorder when making a new 
recording. 

Using Option Items associated with a Worktype, additonal attributes can be provided. 
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